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Preface

Manual Information

Purpose
This manual details the features, installation, operation, maintenance, 
and specifications for the XHD6800+A Aspect Ratio Converter.

Audience
This manual is written for engineers, technicians, and operators 
responsible for installation, setup, maintenance, and/or operation of the 
XHD6800+A Aspect Ratio Converter. 

Revision History
Table P-1. Revision History of Manual

Edition Date Comments
A December 2007 Initial release
XHD6800+A Installation and Operation Manual vii



  
Preface
Writing Conventions
To enhance your understanding, the authors of this manual have 
adhered to the following text conventions:

Obtaining Documents
Product support documents can be viewed or downloaded from our 
Web site. Alternatively, contact your Customer Service representative 
to request a document.

Table P-2. Writing Conventions

Term or 
Convention Description

Bold Indicates dialog boxes, property sheets, fields, buttons, 
check boxes, list boxes, combo boxes, menus, 
submenus, windows, lists, and selection names

Italics Indicates E-mail addresses, the names of books or 
publications, and the first instances of new terms and 
specialized words that need emphasis

CAPS Indicates a specific key on the keyboard, such as 
ENTER, TAB, CTRL, ALT, or DELETE

Code Indicates variables or command-line entries, such as a 
DOS entry or something you type into a field

> Indicates the direction of navigation through a hierarchy 
of menus and windows

hyperlink Indicates a jump to another location within the 
electronic document or elsewhere

Internet address Indicates a jump to a Web site or URL

Note
Indicates important information that helps to avoid and 
troubleshoot problems
viii XHD6800+A Installation and Operation Manual
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Unpacking/Shipping Information
Unpacking a Product

This product was carefully inspected, tested, and calibrated before 
shipment to ensure years of stable and trouble-free service. 
1. Check equipment for any visible damage that may have occurred 

during transit. 
2. Confirm that you have received all items listed on the packing list. 
3. Contact your dealer if any item on the packing list is missing.
4. Contact the carrier if any item is damaged.
5. Remove all packaging material from the product and its associated 

components before you install the unit.
Keep at least one set of original packaging, in the event that you need to 
return a product for servicing. 

Product Servicing
Except for firmware upgrades, XHD6800+ modules are not designed 
for field servicing. All hardware upgrades, modifications, or repairs 
require you to return the modules to the Customer Service center.

Returning a Product
In the unlikely event that your product fails to operate properly, please 
contact Customer Service to obtain a Return Authorization (RA) 
number, then send the unit back for servicing. 
Keep at least one set of original packaging in the event that a product 
needs to be returned for service. If the original package is not available, 
you can supply your own packaging as long as it meets the following 
criteria:
• The packaging must be able to withstand the product’s weight.
• The product must be held rigid within the packaging.
• There must be at least 2 in. (5 cm) of space between the product and 

the container.
• The corners of the product must be protected.
Ship products back to us for servicing prepaid and, if possible, in the 
original packaging material. If the product is still within the warranty 
period, we will return the product prepaid after servicing.
XHD6800+A Installation and Operation Manual ix
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Restriction on Hazardous Substances (RoHS) 
Compliance

Directive 2002/95/EC—commonly known as the European Union (EU) 
Restriction on Hazardous Substances (RoHS)—sets limits on the use of 
certain substances found in electrical and electronic equipment. The 
intent of this legislation is to reduce the amount of hazardous chemicals 
that may leach out of landfill sites or otherwise contaminate the 
environment during end-of-life recycling. The Directive, which took 
effect on July 1, 2006, refers to the following hazardous substances: 
• Lead (Pb)
• Mercury (Hg)
• Cadmium (Cd)
• Hexavalent Chromium (Cr-V1)
• Polybrominated Biphenyls (PBB)
• Polybrominated Diphenyl Ethers (PBDE)
According to this EU Directive, all products sold in the European Union 
will be fully RoHS-compliant and “lead-free.” (See our website for 
more information on dates and deadlines for compliance.) Spare parts 
supplied for the repair and upgrade of equipment sold before 
July 1, 2006 are exempt from the legislation. Equipment that complies 
with the EU directive will be marked with a RoHS-compliant emblem, 
as shown in Figure P-1.

Figure P-1. RoHS Compliance Emblem
x XHD6800+A Installation and Operation Manual
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Waste from Electrical and Electronic 
Equipment (WEEE) Compliance

The European Union (EU) Directive 2002/96/EC on Waste from 
Electrical and Electronic Equipment (WEEE) deals with the collection, 
treatment, recovery, and recycling of electrical and electronic waste 
products. The objective of the WEEE Directive is to assign the 
responsibility for the disposal of associated hazardous waste to either 
the producers or users of these products. As of August 13, 2005, 
producers or users will be required to recycle electrical and electronic 
equipment at end of its useful life, and may not dispose of the 
equipment in landfills or by using other unapproved methods. (Some 
EU member states may have different deadlines.)
In accordance with this EU Directive, companies selling electric or 
electronic devices in the EU will affix labels indicating that such 
products must be properly recycled. (See our website for more 
information on dates and deadlines for compliance.) Contact your local 
sales representative for information on returning these products for 
recycling. Equipment that complies with the EU directive will be 
marked with a WEEE-compliant emblem, as shown in Figure P-2.

Figure P-2. WEEE Compliance Emblem
XHD6800+A Installation and Operation Manual xi



  
Preface
Safety
Carefully review all safety precautions to avoid injury and prevent 
damage to this product or any products connected to it. If this product is 
rack-mountable, it should be mounted in an appropriate rack using the 
rack-mounting positions and rear support guides provided. It is 
recommended that each frame be connected to a separate electrical 
circuit for protection against circuit overloading. If this product relies 
on forced air cooling, it is recommended that all obstructions to the air 
flow be removed prior to mounting the frame in the rack. 
If this product has a provision for external earth grounding, it is 
recommended that the frame be grounded to earth via the protective 
earth ground on the rear panel.
IMPORTANT! Only qualified personnel should perform service 
procedures.

Safety Terms and Symbols in this Manual
WARNING
Statements identifying conditions or 
practices that may result in personal injury 
or loss of life. High voltage is present.

CAUTION
Statements identifying conditions or 
practices that can result in damage to the 
equipment or other property.
xii XHD6800+A Installation and Operation Manual



Chapter 1

Introduction

Overview
The XHD6800+A module is an SD aspect ratio converter (ARC) with 
support for closed captioning processing. 
This chapter introduces the XHD6800+A, and includes the following 
topics:
• “Product Description” on page 2
• “Module Descriptions” on page 5

Note

Due to high levels of heat dissipation, the XHD6800+A modules 
should not be installed in frames without fans.The modules cannot 
be installed in FR6802+DM and 6800/7000 series frames.
XHD6800+A Installation and Operation Manual 1



 Chapter 1: Introduction
Product Description
The XHD6800+A is a reclocking standard definition serial digital 
video distribution amplifier and high quality aspect ratio converter 
(ARC) that converts and processes SD signals in both video and audio 
domains. The XHD6800+A can accept SD-SDI component video 
inputs with embedded audio and ancillary (ANC) data, with 
auto-detectable or user-selectable input standards. The main output path 
provides ARC processing to an output standard identical to the input 
standard (SD-SDI 525 or 625 component video). In the conversion 
process, the audio and ANC data are delayed to ensure synchronicity 
with the output video. Additionally, the XHD6800+A provides a 
secondary path for reclocked SD-SDI signals.
The XHD6800+A has two back module options:
• The standard back module has two SDI reclocked outputs, two SDI 

Program outputs, and two SDI program/monitor outputs. 
• The optional GPIO back module replaces one of the reclocked 

outputs with a GPIO connector. 
It is possible upgrade an XHD6800+Ato a XHD6800+U1 or 
XHD6800+U2 module by entering a purchased license key and 
uploading the appropriate firmware. However, the module cannot 
perform both upconverter and ARC functions at the same time. 
XHD6800+A can be controlled locally (via card edge) or controlled 
and monitored remotely with control software applications such as CCS 
+ Pilot Lite,™ Pilot™, and Navigator™, or other CCS-compliant remote 
control products such as NUCLEUS™ Network Control Panel. 

Main Features
Important XHD6800+A features include the following:
• Input

• One auto-sensing, user selectable SD-SDI input with embedded 
audio data, closed captioning, and error monitoring

• One analog composite genlock input with support for tri- and 
bi-level sync and user-selectable internal 75 ohm load 
termination (jumper); external genlock source

• Four GPI lines (with the optional GPIO-capable back module 
only)
2 XHD6800+A Installation and Operation Manual



 Chapter 1: Introduction
• Output
• Two equalized and reclocked SD-SDI outputs of the SDI input 

(one output if using the optional GPIO-capable back module)
• Two SD-SDI outputs carrying the same program signal with 

embedded audio
• Two configurable SD-SDI outputs carrying either program or 

key signals, and including configurable OSD (on-screen 
display of parameter values)

• Downstream audio delay output
• Selectable output standard and format
• Two GPO lines (with the optional GPIO-capable back module 

only)
• Video Processing

• Aspect Ratio Conversion (ARC) using high quality 10-bit 
video processing

• Motion adaptive deinterlacing for exceptional vertical 
resolution; also includes diagonal processing

• Film 3:2 pulldown detection
• Configurable picture-resizing ARC (H/V size, H/V position)
• Smooth ARC transition
• Advanced cropping with separate controls for top, bottom, left 

and right
• Ten factory ARC presets (4:3, 14:9, 16:9, and 21:9 with 

letterbox and pillar-box modes)
• Variable ARC with five user presets
• Internally-generated background—select one of eight colors
• Propagation delay of one frame through the scalar, and support 

for up to seven frames of delay through the video path
• ANC Processing

• Transfer of closed captioning information across the frame 
synchronizer and scalar

• WSS, VI and AFD processing: signaling, handling and 
insertion

• VBI transparency
XHD6800+A Installation and Operation Manual 3



 Chapter 1: Introduction
• Audio Processing
• Embedded audio processing (de-multiplex, delay/sync, sample 

rate conversion, re-multiplex)
• Support for two groups (eight channels) of embedded audio
• Handling of any embedded compressed audio with fixed delay 

(transparent)
• Processing for 24 bit audio
• Support for compressed and linear PCM in the same audio 

group
• Audio sync/delay
• Incremental audio delay (with a maxiumum of 1.2 seconds)

• Other
• Selectable LOV mode with the following options: Pass, Freeze, 

Black, and Test Pattern
• Built-in SD test generator containing a cross hatch pattern, a 

color bars signal, and a SAG (Safe Area Generator) key
• SD-SDI luma (soft edge rectangle) key output of non-picture 

area
• Support for Copy Protection and thumbnail streaming
• Software key and firmware field upgrade from SD ARC to 

HDTV Upconverter

Applications
The XHD6800+A modules are suitable for the following applications:
• Aspect ratio conversion of content for on-air playout.
• Mobile production. Modular form factor ideal for Mobile Sports 

production.
• Aspect ratio conversion for production facilities.
4 XHD6800+A Installation and Operation Manual



 Chapter 1: Introduction
Module Descriptions

Front Module
Figure 1-1 shows the position of the LEDs and module controls on the 
front of the XHD6800+A modules.

Figure 1-1. Typical 6800+ Module

Table 1-1 on page 6 briefly describes generic 6800+ LEDs, switches, 
and jumpers. 

Module 
status 
LED

Mode select 
rotary 
switch

Navigation 
toggle 
switch

Monitoring 
LEDs

Remote/local 
control jumper

Extractor 
handle

Control 
LEDs
XHD6800+A Installation and Operation Manual 5



 Chapter 1: Introduction
Table 1-1. Generic 6800+ Module Features

Feature Description
Module status 
LEDs

Various color and lighting combinations of these LEDs 
indicate the module state. See “LEDs and Alarms” on 
page 85 for more information.

Mode select 
rotary switch

This switch selects between various control and 
feedback parameters.

Navigation 
toggle switch

This switch navigates up and down through the available 
control parameters:
• Down: Moves down through the parameters
• Up: Moves up through the parameters

Control LEDs Various lighting combinations of these Control LEDs 
(sometimes referred to as “Bank Select LEDs”) indicate 
the currently selected bank. See “Bank Select LEDs” on 
page 30 for more information.

Monitoring 
LEDs

Each 6800+ module has a number of LEDs assigned to 
indicate varying states/functions. See “Monitoring 
LEDs” on page 85 for a description of these LEDs.

Local/remote 
control jumper

• Local: Locks out external control panels and allows 
card-edge control only; limits the functionality of 
remote software applications to monitoring 

• Remote: Allows remote or local (card-edge) 
configuration, operation, and monitoring of the 
XHD6800+A

See page 15 for more information on jumpers.
6 XHD6800+A Installation and Operation Manual



 Chapter 1: Introduction
Back Connectors
Figure 1-2 shows the standard double-slot back module used by the 
XHD6800+A. Figure 1-3 shows the optional double-slot back module 
with GPIO. Table 1-2 describes each back module connector. 
The front and back modules cannot be installed in frames without fans, 
or in FR6802+DM and 6800/7000 series frames.

Figure 1-2. Standard XHD6800+A Back Module

Audio delay 
out

Reference 
in

SD in

SD reclk 
out 2

SD prog 
out 2

SD reclock 
out 1

SDI IN

OUT1 OUT2

OUT3 OUT4

DATA I/O

OUT5GENLOCK

OUT6

SD program /
monitor out 1

SD program /
monitor out 2

SD program 
out 1

Reserved
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Figure 1-3. Optional XHD6800+A Back Module with GPIO

Table 1-2. XHD6800+ Back Module Connector Descriptions 

Back Module Label Description
GPIO Inputs four GPI lines and outputs two GPO 

lines; available on the optional GPIO back 
module only

SD in Inputs SDI-SD video for aspect ratio 
conversion and reclocking 

SD reclock out 1
SD reclock out 2

Outputs SD reclocked video output 
signals.Video from these outputs by-passes the 
module’s aspect ratio converter 

SD program out 1
SD program out 2

Outputs SD video that has processed by the 
module’s aspect ratio converter

Reference in Inputs NTSC, PAL-M, or PAL-B reference 
signal 

SD program/monitor out 1
SD program/monitor out 2 

Outputs the program SD signal for monitoring 
purposes. An on-screen display of XHD6800+ 
control parameters can be enabled on this 
output.

Audio delay 
out

Reference in

SD in

SD reclock 
out 2

SD Program 
out 2

SDI IN
GPIO

OUT2

OUT3 OUT4

DATA I /O

OUT5GENLOCK

OUT6

SD program /
monitor out 1

SD program /
monitor out 2

SD program 
out 1

GPIO
1

8
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 Chapter 1: Introduction
GPIO Connector

Figure 1-4. GPIO Connector Pinouts

8

GPI 1 

1

GND

GPI 2 
GPI 3 

GPI 4 
GND 
GPO 1 
GPO 2 
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 Chapter 1: Introduction
Signal Flow

Figure 1-5. XHD6800+A Block Diagram

Midplane
I/O CCS remote 

monitoring 
and control

Equalizer De-serializer

Closed 
captioning

Video test 
generator

Reticule 
keyer

On screen 
display

SD-SDI in

SD-SDI 
reclocked out 1

Delay/
sync

Genlock in

Video sync

Audio delay 
out

Key 
signal

Q-SEE 
thumbnails

Vertical 
blanking 
interval

AFD/WSS/
VI 

detection

Scaling 
control

GPI out 
x 2

GPI in
x 4

Manual local /
remote control

Audio 
proc

CC/audio/
AFD/WSS/VI 

embedder

3D video 
scalar/de-
interlacer

SD-SDI 
reclocked out 2

SD-SDI 
program out 1

SD-SDI 
program out 2

SD-SDI 
monitor out 1

SD-SDI 
monitor out 2

Genlock

Audio
De-mux
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Chapter 2

Installation

Overview
This chapter describes the XHD6800+A installation process, including 
the following topics:
• “Maximum 6800+ Frame Power Ratings” on page 12
• “Unpacking the Module” on page 13
• “Setting Jumpers” on page 15
• “Installing XHD6800+A Modules” on page 17
• “Upgrading Module Firmware” on page 18

Caution

Before installing this product, read the 6800+ Series Safety 
Instructions and Standards Manual shipped with every frame 
installation and operation manual. This information is also available 
on our Web site. The safety manual contains important information 
about the safe installation and operation of 6800+ series products.

See your frame installation and operation manual for information about 
installing and operating an FR6802+ frame and its components. 
XHD6800+A Installation and Operation Manual 9



 Chapter 2: Installation
Maximum 6800+ Frame Power Ratings
The power consumption for the XHD6800+A modules is less than 
11 W. Table 2-1 shows the maximum allowable power ratings for 
6800+ frames. Note the given maximums before installing any 6800+ 
modules in your frame.
Due to high levels of heat dissipation, the XHD6800+A modules 
should not be installed in frames without fans. The modules cannot be 
installed in FR6802+DM and 6800/7000 series frames.

Table 2-1. Maximum Power Ratings for 6800+ Frames

6800+ Frame 
Type

Max. Frame 
Power 
Dissipation

Max. Number 
of 
XHD6800+A 
Modules

Max Power 
Dissipation 
for Two Slots

FR6802+QXF
(frame with AC 
or DC power 
supply)

120 W 10 12 W

FR6802+XF
(frame with AC 
power supply)

120 W 10 12 W

FR6802+XF
(frame with DC 
power supply)

105 W 10 10.5 W
12 XHD6800+A Installation and Operation Manual



 Chapter 2: Installation
Unpacking the Module

Preparing the Product for Installation
Before you install the XHD6800+A, perform the following:
• Check the equipment for any visible damage that may have 

occurred during transit.
• Confirm receipt of all items on the packing list. See “Checking the 

Packing List” below for more information.

Note
Contact your Customer Service representative if parts are 
missing or damaged.

• Remove the anti-static shipping pouch, if present, and all other 
packaging material.

• Retain the original packaging materials for possible re-use.

See “Unpacking/Shipping Information” on page ix for information 
about returning a product for servicing.

Checking the Packing List

Table 2-2. Available Product Packages

Ordered Product Content Description
XHD6800+A module • One front module

• One back connector
• One XHD6800+A Aspect Ratio Converters 

Installation and Operation Manual

XHD6800+ADR One XHD6800+A standard back connector

XHD6800+AGDR One XHD6800+A optional back connector with 
GPIO
XHD6800+A Installation and Operation Manual 13



 Chapter 2: Installation
Optional License Keys
The XHD6800+A can be upgraded to an XHD6800+U1 or 
XHD6800+U2 upconverter. The following firmware upgrades are 
available. 

With either of these upgrades, you can also purchase 
XHD6800+OPT-CC if you require closed captioning support. To 
purchase additional license keys, contact your Sales representative. To 
activate a license key, see “Adding a License Key” on page 26. 
When upgrading your module from XHD6800+A to any of these other 
types, you will need to upgrade your module firmware as well. 
Instructions for updating module firmware appear in “Upgrading the 
Firmware” on page 18. 
You can update the firmware first, or you can add license keys first. 
However, whichever order you choose, the module will reset itself 
halfway through the procedure. During this first reset, the module status 
LED will blink red indicating a card failure. This is normal. When you 
complete both the upgrade procedure and the addition of license keys, 
the module will display outputs correctly. 

Table 2-3. Optional Soft-key Upgrades

License Key Content Description
XHD6800+A-UG-U1 Upgrade to get utility-quality 

upconversion

XHD6800+A-UG-U2 Upgrade to get broadcast-quality 
upconversion
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Setting Jumpers
The XHD6800+A module has one standard jumper (REM/LOC) for 
remote or local control, and one jumper (J1) for genlock termination. 
Figure 2-1 shows the location of the jumpers.

Figure 2-1. XHD6800+A Jumpers

Local and Remote Jumper Settings
Follow this procedure to set the REM/LOC jumper for either remote or 
local control:
1. Locate the REM/LOC control jumper on the module (beside the 

mode select rotary switch). Figure 2-1 shows the standard location 
of the REM/LOC jumper.

REM/LOC 
(remote/local) jumper

Jumper J1
genlock termination
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2. Place a jumper on pins 1 and 2 to set the module for Remote 
control, or pins 2 and 3 to set the module for Local control. See 
Figure 2-2.

Figure 2-2. Jumper Settings for Remote and Local Control

Note

You must configure modules for local or remote operation prior to 
power-up. To change the configuration, first remove power from the 
module, reset the jumper, and then reapply power. The white 
triangle near the jumper pins on the module indicates pin 1.

See “Changing Parameter Settings” on page 28 for more information on 
local/remote control jumper functionality.

Genlock Termination Jumper Settings
Follow this procedure to set the Genlock Termination jumper J1:
1. Locate jumper J1 on the module, near the back of the module. 

(Figure 2-1 on page 15 shows the location of the jumper.)
2. Place a jumper on pins 1 and 2 to set the module for No 

Termination, or pins 2 and 3 to set 75Ω Onboard Termination 
(see Figure 2-3).

Figure 2-3. Genlock Termination Settings

1      2      3 1      2      3

Remote control Local control

1      2      3 1      2      3

No Termination 75Ω Termination
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Installing XHD6800+A Modules
The XHD6800+A modules have double-width back connectors. Due to 
high levels of heat dissipation, the XHD6800+A modules should not be 
installed in frames without fans. The modules cannot be installed in 
FR6802+DM and 6800/7000 series frames.

Caution

Before inserting, removing, or replacing a back module, you must 
power down the frame. Failure to do so could result in damage to 
the frame, modules, or power supply. 

These modules require no specialized installation or removal 
procedures. However, if you are installing both front and rear modules, 
ensure that the back module is installed first before plugging in the front 
module. Likewise, ensure that the front module is unplugged from the 
frame before removing the rear module. See the FR6802+ Frames 
Installation and Operation Manual for information about installing and 
operating an FR6802+ frame and its components.
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Upgrading Module Firmware
Firmware upgrading is a routine procedure that you must perform to 
install newer versions of software on 6800+ modules. CCS Pilot, 
Co-Pilot, or Navigator software version 4.0 or later is required for this 
procedure. The frame must contain or be connected to another frame 
that contains an ICE6800+ or a 6800+ETH module. During the 
upgrade procedure, the affected modules are automatically rebooted 
twice.
In the unlikely event that the upgrade fails (because of such situations 
as network interruptions, power failures, etc.), the module may not 
respond to controls and will appear to be non-functional. In that event, 
follow the procedures described in “Correcting a Failed Upgrading 
Procedure” on page 22.

Note

You can replace the XHD6800+A firmware with xhd6800+ud.zip 
(up-converter) for the ‘U1’ and ‘U2’ options, or xhd6800+ad.zip 
(ARC) for the ‘A’ option. Both sets of firmware, and therefore both 
feature sets, cannot exist on the module at the same time. 

The XHD6800+U1 and U2 firmware requires a license key to 
operate on XHD6800+A hardware. It also requires optional license 
keys to unlock some features. See your XHD6800+U1 and 
XHD6800+U2 Broadcast Upconverters Installation and Operation 
Manual for more information. 

License keys allowing you to use XHD6800+A firmware on a 
XHD6800+U1 or U2 module are not available. 

Upgrading the Firmware
You can upgrade your 6800+ module’s firmware using the Software 
Upgrade tool. This tool is included with CCS Pilot, Co-Pilot, or 
Navigator software version 4.0 or later.

Caution

The File Transfer tab of the Configuration window is not meant to 
be used for firmware upgrades. Use the Software Upgrade tool to 
upgrade module firmware.
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To upgrade your module’s firmware, follow these steps:
1. Download the most recent appropriate upgrade package from our 

Web site or from your CD-ROM.
2. If the affected module has not been discovered, perform the 

Discovery operation, as described in “Discovering an XHD6800+A 
Module” on page 29. 

Note
Information about discovering modules can also be found in 
your CCS software application manual or online help. (If you 
cannot discover the device, see “Manually Adding a Device to 
the Discovery or Network Folder” on page 23.)

3. From the Tools menu, select Software Upgrade. 
The Software Upgrade window opens or is brought to the 
foreground.

Figure 2-4. Software Upgrade Tool’s New Transfer Tab

4. On the New Transfer tab, click Add.
The Device Selection dialog box opens.

Package Info 
includes a list of the 
components 
contained in the ZIP 
file. 

Version Info lists 
the firmware version 
currently installed on 
the module.
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5. Select one or more devices, and then click OK to close the Add 
Device dialog box.

Note
You can only add one device from each IP address. All items in 
a frame have the same IP address. 

The selected devices appear in the table under Device Name. These 
devices will receive the same upgrade package. 

6. Before proceeding with the firmware upgrade, you can—
• Highlight the module’s position in the Navigation window by 

clicking Find Device. 
• View the firmware version currently installed on the module by 

clicking Version Info.
7. Press Browse... to select the firmware upgrade package (ZIP file). 

A standard Windows File Selection dialog opens. 
8. Choose the upgrade ZIP file on a local or network drive. 

The selected file’s path name is displayed in the edit box to the left 
of the Browse… button.

Note
The extraction process of the ZIP file is handled as part of the 
upgrade process. You do not need to extract the files yourself. 
You can view the contents of the ZIP file by clicking Package 
Info. 
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9. Press Submit Transfer... 
A dialog box opens, requesting confirmation that you want to 
proceed with the request. If you have multiple devices selected, 
multiple transfer tasks are submitted—one per device.
The transfer now progresses. You may minimize the Software 
Upgrade window, continue with other tasks, or switch to the 
Progress tab to view the status of the transfers. 

Note
Closing the Software Upgrade window does not effect any of 
the transfer processes that may be running in the background. 
If you try to log off or exit the CCS software while a transfer is 
underway, a notification window will alert you that processes 
are still active and will ask if you want to terminate these 
processes.

10. To monitor the progress of the firmware upgrade procedure, click 
the Progress tab. When the firmware upgrade is complete, 
Completed is displayed in the Transfer Status column.

Figure 2-5. Firmware Upgrade Complete

Note

If you are in the process of upgrading your module from an 
XHD6800+A to another variant of XHD6800+, and the firmware 
does not match the license key, the module will display a test 
pattern after the firmware upgrade procedure has completed. This 
is normal. When you complete both the upgrade procedure and the 
update of the license key, the module will display a correct output. 
See “Adding a License Key” on page 26. 
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Correcting a Failed Upgrading Procedure
Firmware upgrades may fail in the event of network interruptions, 
power failures, or if the wrong upgrade package was transferred to the 
module. These problems can be corrected by upgrading the firmware 
while the module is in Boot Loader mode. The upgrade won't work 
unless you put the module in Boot Loader mode.

Note

If you have not already downloaded the most recent appropriate 
upgrade package from our Web site or from your CD-ROM, do so 
now.

Putting the Module in Boot Loader Mode
Follow these steps to put your the module in Boot Loader mode:
1. Remove the affected module from the 6800+ frame.

Figure 2-6. Buttons on a Typical Card Edge

2. Set the hex switch to F. 
3. While pressing the Navigation toggle switch down, reinsert the 

module into the frame.
If your device is listed in the Discovery or Network folder, you can 
continue the firmware upgrade as described in “Upgrading the 
Firmware” begining with step 3 page 18. If not, you must manually add 
the device to the Discovery or Network folder. To do this, see the next 
section. 

Hex switch (mode 
select rotary switch)

Navigation toggle 
switch
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Manually Adding a Device to the Discovery or Network Folder
If your device is not listed in the Discovery or Network folder, you 
must manually add it to these folders. After you add the device, you can 
use the Software Upgrade dialog box to continue with the module 
firmware upgrade.
To manually add a device to the Discovery or Network folder, follow 
these steps:
1. Enter Build mode, and then drag or copy and paste the module’s 

device icon from the Catalog folder into the Network or Discovery 
folder.

2. Right-click the device icon, and then select Properties. 
3. On the Device tab of the Navigation Properties box, enter the IP 

address of the frame that holds the module. (See Figure 2-7.)

Figure 2-7. Navigation Properties Box

Caution

Do not make changes in the last field (located above and to the 
right of the Set Default button). If you do, you will need to begin the 
process of adding devices to the Discovery or Network folder 
again. 

Do not make changes in 
this field

Enter frame IP address here

Frame number=0 Slot number=17Must be set to 1
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4. In the third field, enter
1.0.[slotnumber]

(where, for example, 1.0.5 would refer to the module in slot 5 of the 
frame number 0). 

5. Close the window.
6. You can now continue your firmware upgrade as described in 

“Upgrading the Firmware” begining with step 3 on page 18. 
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Chapter 3

Configuration and Operation

Overview
This chapter describes how to operate the XHD6800+A using 
card-edge controls or by using a CCS software application such as 
+ Pilot Lite, Pilot, or Navigator.
See the following documents for detailed information on how to operate 
this product remotely:
• + Pilot Lite User Manual for serial interface
• CCS Pilot, CoPilot, Navigator, or NUCLEUS Network Control 

Panel, LCP-3901-1U/RCP-CCS-1U manuals for Ethernet interface
The following topics are discussed in this chapter:
• “Operating Notes” on page 26
• “Changing Parameter Settings” on page 28
• “Configuring Video Settings” on page 33
• “Configuring Aspect Ratio Conversion” on page 37
• “Configuring Audio” on page 51
• “Changing Parameter Settings Using Card-Edge Controls” on 

page 29
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Operating Notes
When setting the control parameters on the XHD6800+A, observe the 
following:
• If you make changes to certain parameters, other related parameters 

may also be affected. 
• When you change a parameter, the effect is immediate. However, 

the module requires up to 20 seconds to save the latest change. 
After 20 seconds, the new settings are saved and will be restored if 
the module loses power and must be restarted. 

• The manufacturer recommends that you terminate any unused 
coaxial output connectors with a 75Ω connector.

Q-SEE Compliant Thumbnails
The XHD6800+A supports Q-SEE compliant thumbnails. To use 
Q-SEE compliant features, you must install the XHD6800+A in an 
FR6802+QXF frame that also contains a 6800+ETH module. 
When you open a Control window in Pilot or Navigator for the 
6800+ETH module, all Q-SEE compliant modules provide thumbnails 
on a Video Streaming tab. In addition, the XHD6800+A module’s 
Control windows have a new Streaming tab where a thumbnail, 
updated at up to three frames per second, is displayed. 
For more information on Q-SEE compliant thumbnails, see your 
FR6802+QXF Frames Installation and Operation Manual.

Adding a License Key 

Note

For assistance with a license key, or to purchase a license key, 
please contact your Sales representative. See “Optional License 
Keys” on page 14. 

To enter a license key to convert your XHD6800+A to an 
XHD6800+U1 or XHD6800+U2 functionality, your CCS software 
must be in Control mode. 
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Follow these steps: 
1. Select the XHD6800+A module in the Navigation pane, right 

click, and then select Control to open the module’s Control 
window. 

2. If it is not already selected, click on the Parameters tab. 
3. Select General in the tree view, and then type your license key in 

the License Key field.
If your license key is valid, the Installed Options field will display the 
features that are enabled on the module. 

Note

During the process of upgrading your module from an XHD6800+A 
to another variant of XHD6800+, the module status LED will blink 
red if the firmware does not match the license key. This is normal. 
You must complete both the upgrade procedure and the update of 
the license key for the module to display a correct output. See 
“Upgrading the Firmware” on page 18. 
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Changing Parameter Settings
There are two ways to change the parameters that control your module’s 
operation: CCS software applications and card-edge controls.
Using CCS software applications, such as + Pilot Lite, Pilot, or 
Navigator, you can view, set, and confirm your module’s parameter 
settings from your computer’s monitor. Using the card-edge controls, 
you can set parameter using the module’s rotary hex and navigation 
switches. 
You can use the information in this chapter to configure and operate 
your XHD6800+A using a CCS software application or the module’s 
card-edge controls. For more information about setting parameters 
using CCS software application or by using the module’s card-edge 
control, see “Changing Parameters Using CCS Software” on page 28 
and “Changing Parameter Settings Using Card-Edge Controls” on 
page 29 respectively. 
A complete list of XHD6800+A control parameters can be found in 
Chapter 4: “Parameters, LEDs, and Alarms” on page 59.

Changing Parameters Using CCS Software
Before using CCS software applications to change your module’s 
parameter settings, you must refresh (+ Pilot Lite) or discover (Pilot 
and Navigator) the module. Refresh and Discovery are the processes by 
which your CCS software finds, and then connects to your module.

Refreshing Your Module Using + Pilot Lite
When using + Pilot Lite to change your XHD6800+A control 
parameters, you must “refresh” the control connection between your 
6800+ frame and PC. To refresh the connection, from the + Pilot Lite 
menu bar, select File > Refresh. For information about controlling a 
device using + Pilot Lite, see your + Pilot Lite User Manual.
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Discovering an XHD6800+A Module
To discover your module, your Pilot or Navigator software must be in 
Build mode. Follow these steps: 
1. If the Discovery window is not open, click Tools > Discovery in the 

main menu. 
A Discovery window opens, most likely in the bottom left corner of 
the screen. 

2. Click Options, and then click Add.
3. Enter the IP address of the frame that contains your module, the 

frame that contains your ICE6800+ module, or the frame that 
contains a 6800+ETH module that provides access to your module. 

4. Click OK to close the Add IP address window, and then OK again 
to close the Discovery Options window. 

5. Click Start. 
This triggers Pilot or Navigator to run a discovery. 

6. When your discovery is complete, Discovery Completed is 
displayed in the Discovery window. To continue, click Save, to 
save the contents of your discovery to the Discovery folder of the 
Navigation pane. 

You can now switch to Control mode by selecting Operational Mode > 
Control from the main menu. Double-click XHD6800+A in the 
Navigation pane. The Control window opens displaying the module’s 
controls.

Changing Parameter Settings Using Card-Edge Controls
Using the module’s rotary and navigation switches, you can change 
XHD6800+A parameter settings at the card edge. You can view and 
confirm your changes using the On-screen display feature (see 
“Enabling On-Screen Display” on page 31).
Follow these steps to change the XHD6800+A parameter settings at the 
card edge:
1. Rotate the mode select rotary switch (hex switch) to “0.”
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2. Once the hex switch is set to “0,” toggle the navigation switch up or 
down to select a bank. 
View the three control LEDs next to the navigation toggle switch to 
see which bank is currently selected.

3. Rotate the hex switch to the parameter number (1 to 9) or letter 
(A to F) of the option you want to set.

4. Toggle the navigation switch to select and set the value of the 
chosen parameter.

5. Rotate the hex s witch to another parameter number/letter in the 
current bank, and then repeat step 4.
or
Rotate the hex switch to “0” again to select a different bank, and 
then repeat steps 3 and 4.

Table 3-1. Bank Select LEDs

Bank 
Number

 Bank 0 LED
(first top LED)

Bank 1 LED
(second top LED)

Bank 2 LED 
(third top LED)

0 Off Off Off

1 On Off Off

2 Off On Off

3 On On Off

4 Off Off On

5 On Off On

6 Off On On

7 On On On

8 On (blinking) On (blinking) On (blinking) 
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Throughout this chapter, in the Parameter Navigation sections, the bank 
and hex switch positions for each configuration setting are listed in 
square brackets (for example, [0, 2]) beside or below the parameter 
name.

Note

The manufacturer recommends that you use the available 6800+ 
software control options (serial/local or Ethernet/remote) to aid in 
viewing, setting, and confirming parameter values.

Enabling On-Screen Display
You can use the On-screen Display (OSD) Monitoring feature to view 
the current parameter selections on your output display. When the 
On-Screen Display parameter is turned on, the current parameter 
selections are displayed on the module’s SD program/monitor out 1 and 
SD program/monitor out 2 outputs. This feature makes configuring the 
XHD6800+A using the card-edge controls much easier. 
To enable On-screen Display (OSD) Monitoring make the following 
selections: 

Recalling Default Parameter Settings
You can use the module’s Factory Recall parameter to return all of the 
module’s parameters to factory default settings. In the XHD6800+A 
control parameter list (see “Overview” on page 59), each factory 
default setting appears in bold.
To return this module to its default settings, make the following 
selections:

Setting Description Parameter Navigation
Enable OSD monitoring. Video Setup  Output  On-Screen Display

[0, 2]
On

Set OSD transparency value. OSD Transparency 
Level 
[0, 3]

0–15

Setting Description Parameter Navigation
Recall factory default settings. Other Setup  Other Factory Recall [0, F] Yes
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Reading Software and Hardware Versions
You can see the current software and hardware versions of the 
XHD6800+A by checking the Hardware Version and Firmware Version 
read-only parameters located at the end of the parameter list (see 
“Overview” on page 59). These parameters appear in the OSD and on 
CCS-enabled control panels or CCS software applications such as Pilot 
or Navigator.
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Configuring Video Settings
The following section provides information about configuring the 
XHD6800+A video settings including the following:
• “Selecting Output Video Standards” on page 33
• “Synchronization and Delay” on page 35
• “Setting Motion Threshold Mode” on page 36

Selecting Output Video Standards
There are three options that you can use to select your module’s output 
video standard: Auto, 525, or 625. The video input to the module must 
match the Output Video Standard setting. All other types of input 
video are handled according to the Loss of Video Output parameter 
option. 
Each Output Video Standard parameter option is described below: 
• Auto  With this option selected, the XHD6800+ automatically 

detects the video standard of incoming video and sets the output 
standard to match. 

• 525 With this option selected, the XHD6800+ only accepts 
525 video input for aspect ratio conversion; any other signal will be 
treated according to the Loss of Video Output parameter option 
setting. 

• 625  With this option selected, the XHD6800+ only accepts 
625 video input for aspect ratio conversion; any other signal will be 
treated according to the Loss of Video Output parameter option 
setting. 

The Loss of Video Output parameter option can be set as follows:
• Pass  Displays the unknown input in the currently selected video 

standard (valid video standard with correct timing) 
• Black Displays black video 
• Freeze Displays a single field/frame of input video 
• Test Pattern Displays a selected test pattern 
• Sync Pass  Displays input video without processing (with most 

likely invalid video timing, which would be detected by 
downstream equipment as invalid video) 
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Selecting Video Output Standards
To select video input and output standards and configure your loss of 
video settings, make the following selections:

Setting Description Parameter Navigation
Display detected video 
standard.

Video 
Setup

Input Input Video Standard 
Detect [4, 2]

(detected standard)

Select an output standard. Output Output Video Standard 
[0, 2]

• Auto 
• 525
• 625

Select a loss of video option. Loss of Video Output [0, 
5]

• Pass
• Black
• Freeze
• Test Pattern
• Sync Pass

If you selected Test Pattern as 
the Loss of Video parameter 
option, select the test pattern 
you want to display. 

Test Pattern Select [0, 6] (select a pattern)
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Synchronization and Delay
Before aspect ratio conversion, the SD-SDI input signal is processed by 
the module’s frame synchronizer. The frame synchronizer automatically 
detects and locks to the genlock reference signal for video timing 
alignment. The frame synchronizer either drops or repeats video frames 
to achieve synchronization.
During aspect ratio conversion, delay is added to the SDI input signal in 
the main video processing path. The amount of delay to the primary 
signal through the scalar is one frame.
To compensate for delays from external, upstream processes, you can 
use the Input Frame Delay parameter to add processing delay. The 
Input Frame Delay parameter provides a delay range between 0 to 6 
frames in one-frame increments.

Audio Synchronization and Delay
Audio is synchronized to video by applying the same frame sync delay 
and converter delay to the audio associated with that video path. By 
changing the Input Frame Delay control, you can adjust the frame 
sync delay and trigger the audio to re-synchronize with the video. The 
audio synchronization will not occur immediately and will take roughly 
10 seconds per frame of delay in order to prevent any audio “glitch.”
You can add additional delay using the Audio Pair 1 Delay to Audio 
Pair 4 Delay parameters. For information about setting additional audio 
delay, see “Setting Audio Pair Delay” on page 54.
The user delay is always applied in addition to the audio 
synchronization and will cause an audio glitch to occur when the user 
delay changes.
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Configuring Input Reference Source and Input Frame Delay
To configure your input reference source and input frame delay, make 
the following selections:

Setting Motion Threshold Mode
You can use Motion Threshold mode to set how the XHD6800+A 
determines the difference between motion in the input video image and 
signal noise. When Motion Threshold is set to Auto, the module sets 
the threshold value to an optimal level. When set to Manual, you can 
use the Motion Threshold control to set the threshold value between 1 
and 16, where 16 is used for images with high noise levels. 
To set Threshold Motion mode, make the following selections:

Setting Description Parameter Navigation
Select the genlock source. Video Setup  Reference  Genlock Source 

[0, D]
• External Ref
• Frame Ref
• Free Run
• Delay

Select the video standard of the 
genlock source. (The applicable 
525 or 625 options are displayed 
in the OSD. If the standard is 
mismatched with the genlock 
source, the Reference LED will 
light.)

Reference Standard 
[0, E]

• Auto
• NTSC/PAL-M
• TLS 720p59.94
• TLS 1080i59.94
• TLS 1080p29.97
• PAL-B
• TLS 720p50
• TLS 1080i50
• TLS 1080p25

Set the video input frame delay, 
if required.

 Input Input Frame Delay 
[1, 3]

0–6 (frames)

Setting Description Parameter Navigation
Set the Motion Threshold mode. Video Setup  Processing Motion Threshold mode 

[3, A]
• Auto
• Manual

If you set the Motion Threshold 
parameter to Manual, enter the 
threshold value. 

Motion Manual Threshold
[3, B]

1–16
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Configuring Aspect Ratio Conversion
The XHD6800+A can perform either standard or custom aspect ratio 
conversions (ARCs). Using the ARC Preset Select parameter, you can 
select from one of the following standard aspect ratios:
• 4:3->4:3 Pillar
• 4:3->14:9 Pillar
• 4:3->16:9 Cut
• 4:3->16:9 Anamorphic 
• 4:3->21:9 Letter
• 16:9->16:9 Letter
• 16:9->14:9 Letter
• 16:9->4:3 Cut
• 16:9->4:3 Anamorphic
• 16:9->21:9 Letter
You can use the module’s custom ARC control parameters to create a 
custom output aspect ratio that can be saved as an ARC Preset. Saved 
custom ARC Presets are listed as an ARC Preset Select parameter 
option with the module’s list of standard ARC settings. For information 
about creating a custom ARC preset, see “Creating a Custom Aspect 
Ratio” on page 40.
See Figure 3-1 on page 38 for a graphic illustration of the standard 
aspect ratios.
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Figure 3-1. 4:3 to 16:9 Standard ARC Settings
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4:3 Display Input Signal
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Figure 3-2. 16:9 to 4:3 Standard ARC Settings 
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XHD6800+A Installation and Operation Manual 39



 Chapter 3: Configuration and Operation
Selecting a Standard ARC Preset
To select a standard aspect ratio for the output image, make the 
following selection:

Creating a Custom Aspect Ratio
You can scale and pan the output image to any size and location by 
using the module’s custom aspect ratio feature. You can use the ARC 
Scaling and ARC Offset controls to adjust the size and position of your 
custom ARC settings. Custom ARCs can then be saved as ARC Presets. 
You can save up to five ARC Presets.
Descriptions of the controls are listed below.
• ARC H Scale–sets the horizontal size of the output image 

anywhere between 50% and 150% of the output screen size. 
• ARC V Scale–sets the vertical size of the output image anywhere 

between 60% and 150% of the output screen size.
• ARC H Offset–places the horizontal center of the output image 

anywhere between -50% and 50% of the output screen size. 
• ARC V Offset–places the vertical center of the output image 

anywhere between -50% to 50% of the output screen size. 
To create and save a custom ARC preset, follow these steps
1. To set the horizontal and vertical scaling and offset values for your 

custom ARC, make the following selections:

Setting Description Parameter Navigation
Select an standard or custom ARC 
preset. Before selecting Preset 1–
Preset 5, you must create, and then 
save a custom ARC preset. See 
“Creating a Custom Aspect Ratio” 
on page 40. 

Video Setup  Processing  ARC Preset Select 
[1, 4]

(select an ARC 
Preset)

Setting Description Parameter Navigation
Select the Custom ARC option. Video Setup  Processing  ARC Preset Select

[1, 4]
Custom

Set the ARC horizontal scaling 
value.

 ARC H Scale [1, 7] 50% – 150% 
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2. To save the current custom ARC settings as an ARC preset, make 
the following selection: 

3. Wait approximately two seconds for the module to process the 
command.
When the save operation is complete, the ARC Preset Save 
parameter option returns to None.

You can at any time select your new ARC Preset for output. For more 
information see “Selecting a Standard ARC Preset” on page 40.

Recalling Standard and Custom ARC Presets
You can use the ARC Preset Recall parameter to recall and view 
standard and custom ARC preset settings without changing the output 
image. 
The ARC Preset Recall parameter will overwrite the following custom 
aspect ratio parameters: ARC H Scale, ARC V Scale, ARC H Offset, 
and ARC V Offset. If you perform an aspect ratio recall when ARC 
Preset Select is set to Custom, the output image aspect ratio will revert 
to the recalled aspect ratio.
To recall a standard or custom ARC preset, make the following 
selections:

Set the ARC horizontal offset.  ARC H Offset [1, 9] -50.00% to 50.00% 

Set the ARC vertical scaling 
value.

 ARC V Scale [1, 8] 60% – 150% 

Set the ARC vertical offset.  ARC V Offset [1, A] -50.00% to 50.00% 

Setting Description Parameter Navigation

Setting Description Parameter Navigation
Save the current ARC as a 
preset.

Video Setup  Processing  ARC Preset Save 
[1, C]

(Select Preset 1–5)

Setting Description Parameter Navigation
Save the current ARC as a 
preset.

Video Setup  Processing  ARC Preset Recall 
[1, D]

(select a preset)
XHD6800+A Installation and Operation Manual 41



 Chapter 3: Configuration and Operation
Active Format Description
Active Format Description (AFD) transmits data in the VANC portion 
of the SDI signal, enabling both 4:3 and 16:9 television monitors to 
optimally present video with preset ARC and safe area information. 
Without AFD, converted video may appear distorted or “cut off” when 
it appears on different monitors. The XHD6800+A can encode or 
decode AFD; it can also encode or decode earlier Video Index (VI) and 
Wide Screen Signalling (WSS) formats.
The AFD feature of the XHD6800+A complies with SMPTE 2016 and 
includes nine possible 4:3 configurations and eight possible 
configurations in 16:9. Figure 3-4 on page 45 describes the 4:3 AFD 
configurations; Figure 3-5 on page 46 describes the 16:9 AFD 
configurations.

AFD, VI, and WSS Detection
AFD, VI, and WSS data that is embedded in the incoming video can be 
detected by the XHD6800+A, and read from the following input 
parameters that are found in the Video Setup > Input path: 
• AFD Detected 
• VI Scan Detected (Use the VI Detect Line Field 1 and VI Detect 

Line Field 2 parameters to determine where in the video signal to 
look for VI information)

• VI AFD Detected
• WSS Detected (Use the WSS Detect Line parameter to determine 

where in the video signal to look for WSS information)

AFD, VI, and WSS Processing
Incoming AFD, VI, and WSS data can be used for automatic aspect 
ratio control when the ARC Preset parameter is set to one of these 
values in the Video Setup > Output path: 
• AFD
• AFD (ALTR)
• VI
• WSS
• WSS (ALTR) 
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See Figure 3-6 on page 47, Figure 3-7 on page 48, Figure 3-8 on 
page 49, and Figure 3-9 on page 50 for descriptions of how the 
automatic ARC control will act when given an AFD, VI, or WSS code 
input.

AFD, VI, and WSS Output
AFD, VI, and WSS data can be inserted into an output video stream 
either manually or automatically. This function is controlled by the 
AFD Insert, VI Insert, and WSS Insert parameters located in the 
Video Setup > Output path (in Table 4-1).
The Auto option of the AAFD Insert, VI Insert, and WSS Insert 
parameters will embed the data that is automatically selected by the 
module, based on one of the following:
• The current ARC settings (via Video Setup > Output, in 

Table 4-1).
• The current AFD/VI/WSS code input that is detected in the 

incoming video signal
• A selected option in the ARC Preset parameter (via Video Setup > 

Output, in Table 4-1)
If you select User instead of Auto in the AFD Insert, VI Insert, and 
WSS Insert parameters, you can change the output code by selecting a 
different option in AFD Select, VI Select, or WSS Select. These 
parameters are also located in the Video Setup > Output path(in 
Table 4-1).
Additionally, if you are using VI according to the SMPTE Proposed 
RP-186+ standard as of January 11, 2007, you must ensure you have 
enabled the standard by following this path: Output > Embedding > 
VI Embed with AFD on Table 4-1 (default setting is No).
In the event that the current ARC is controlled by AFD, VI, or WSS, 
and this data disappears from the input signal, the XHD6800+ provides 
you with two options:
• Keep the current aspect ratio as set by the last AFD, VI, or WSS 

data.
• Reset to the aspect ratio settings that were in use before the AFD, 

VI, or WSS data took control.
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The Auto Arc Reset parameter (Table 4-1) controls this feature. Select 
Yes to have the module reset to older values in the event of a loss of 
data; select No (the default) to retain the current ARC settings in the 
event of a loss of data.
At this time, Bar Data and Pan-Scan for VI and AFD are not 
supported.

AFD Descriptions
In the following pages, Figures 3-4 to 3-9 show the different AFD code 
descriptions. Comparable WSS and VI templates are included in the 
SD-SDI descriptions.

Figure 3-3. Explanation of AFD Diagrams

Bounding box represents
the coded frame.

The smallest rectangle enclosing
the white regions indicates the area
of essential picture information.

Black regions indicate areas
of the picture that do not
contain useful information and
should be cropped by the
receiver where appropriate.

Gray regions indicate areas of the picture
that may be cropped by the receiver
without significant loss to the viewer.
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Figure 3-4. Available AFD Select Options when OutAspectRatio is Set to 4:3

AFD 4:3 code and description

Illustration in a
4:3 coded frameWSS name

16:9 Top

14:9 Top

>16:9 

Full Frame

16:9 Center

14:9 Center

Full A 14:9 

None

None

Description

Image with a 16:9 aspect ratio and with an
alternative 4:3 center as a vertically centered

letterbox in a 4:3 coded frame

alternative 14:9 center as a vertically centered
Image with a 16:9 aspect ratio and with an

letterbox in a 4:3 coded frame

Image with a 4:3 aspect ratio and with an
alternative 14:9 center in a 4:3 coded frame

Image with 14:9 aspect ratio as a vertically
centered letterbox in a 4:3 coded frame

Image with a 16:9 aspect ratio as a vertically
centered letterbox in a 4:3 coded frame

Image is full frame, with an aspect ratio that is
the same as the 4:3 coded frame

Image with aspect ratio greater than 16:9 as
a vertically centered letterbox in a 4:3 coded

frame

Image with a 14:9 aspect ratio as letterbox at
the top of a 4:3 coded frame

Image with a 16:9 aspect ratio as letterbox at
the top of a 4:3 coded frame

AFD and VI Select 
parameter options

16:9 Top

14:9 Top

>16:9 in 4:3

16:9 L

14:9 L

4:3 Full

4:3 A 14:9 

16:9 L A 4:3

16:9 L A 14:9
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Figure 3-5. Available AFD Select Options when OutAspectRatio is Set to 16:9

AFD 16:9 code and description

Illustration in a
16:9 coded frame

>16:9 in 16:9
AFD Code: 0100

AFD and VI Select 
parameter options

16:9 A 4:3
AFD Code: 1111

14:9 P
AFD Code: 1011

4:3 P A 14:9 
AFD Code: 1101

16:9 A 14:9 
AFD Code: 1110

16:9 Full 
AFD Code: 1000

16:9 Prtctd
AFD Code: 1010

4:3 P 
AFD Code: 1001

None

WSS name

None

None

None

None

Anamorphic

None

None

Description

Image with a 16:9 aspect ratio and with
an alternative 4:3 center in a 16:9 coded

frame

Image with a 16:9 aspect ratio and with
an alternative 14:9 center in a 16:9

coded frame

Image with a 4:3 aspect ratio and with an
alternative 14:9 center as a horizontally
centered pillarbox image in a 16:9 coded

frame

Image with a 14:9 aspect ratio as a
horizontally centered pillarbox image

in a 16:9 coded frame

Image is full frame, with a 16:9 aspect
ratio and with all image areas protected

Image with a 4:3 aspect ratio as a
horizontally centered pillarbox image

in a 16:9 coded frame

Image is full frame, with an aspect ratio
that is the same as the 16:9  coded

frame

Image with aspect ratio greater than 16:9
as a vertically centered letterbox in a

16:9 coded frame
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Figure 3-6. Available AFD Select, VI Select, and WSS Select Options When Converting from 
4:3 to 16:9

4:3 to 16:9 conversion

Illustration in a
4:3 coded frameWSS name

16:9 Top

14:9 Top

>16:9 

Full Frame

16:9 Center

14:9 Center

Full A 14:9 

None

None

AFD and VI Select 
parameter options

16:9 Top

14:9 Top

>16:9 in 4:3

16:9 L

14:9 L

4:3 Full

4:3 A 14:9 

16:9 L A 4:3

16:9 L A 14:9

Conversion Conversion (Alternative)
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Figure 3-7. Available AFD Select, VI Select, and WSS Select Options When Converting from 
4:3 to 4:3

4:3 to 4:3 conversion
Conversion
(Alternative)Conversion

Illustration in a
4:3 coded frameWSS name

16:9 Top

14:9 Top

>16:9 

Full Frame

16:9 Center

14:9 Center

Full A 14:9 

None

None

AFD and VI Select 
parameter options

16:9 Top

14:9 Top

>16:9 in 4:3

16:9 L

14:9 L

4:3 Full

4:3 A 14:9 

16:9 L A 4:3

16:9 L A 14:9
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Figure 3-8. Available AFD Select, VI Select, and WSS Select Options When Converting from 
16:9 to 4:3

16:9 to 4:3 conversion

Illustration in a
16:9 coded frame

Conversion 
(Alternative)Conversion

AFD and VI Select 
parameter options

>16:9 in 16:9
AFD Code: 0100

16:9 A 4:3
AFD Code: 1111

14:9 P
AFD Code: 1011

4:3 P A 14:9 
AFD Code: 1101

16:9 A 14:9 
AFD Code: 1110

16:9 Full 
AFD Code: 1000

16:9 Prtctd
AFD Code: 1010

4:3 P 
AFD Code: 1001

None

WSS name

None

None

None

None

Anamorphic

None

None
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Figure 3-9. Available AFD Select, VI Select, and WSS Select Options from 16:9 to 16:9

16:9 to 16:9 conversion
Conversion 
(Alternative)ConversionIllustration in a

16:9 coded frame

>16:9 in 16:9
AFD Code: 0100

AFD and VI Select 
parameter options

16:9 A 4:3
AFD Code: 1111

14:9 P
AFD Code: 1011

4:3 P A 14:9 
AFD Code: 1101

16:9 A 14:9 
AFD Code: 1110

16:9 Full 
AFD Code: 1000

16:9 Prtctd
AFD Code: 1010

4:3 P 
AFD Code: 1001

None

WSS name

None

None

None

None

Anamorphic

None

None
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Configuring Audio 
The XHD6800+A can detect up to four embedded audio groups (eight 
uncompressed or compressed audio channel pairs) that are present in 
the input SDI video stream. You can then select up four input audio 
channel pairs and embed them as two audio groups in the SDI output 
video stream. Using the XHD6800+A audio control parameters you can 
perform the following audio input and output operations:
• Select detected input audio groups/pairs to demux
• Select audio groups/pairs to re-embed in the SDI output
• Set audio delay on each output audio channel pair (uncompressed 

sources only)
• Set audio gain on each output audio channel pair (uncompressed 

sources only)
• Set audio bypass on each output audio channel pair for compressed 

audio source
• Mute all output audio

Demuxing Input Audio Groups/Pairs
When the XHD6800+A detects embedded audio in the SDI input video 
stream, it displays the number of audio groups present (up to four) and 
whether or not the audio present in each audio channel pair is 
compressed or uncompressed. 
The Audio Group Present feedback parameter indicates whether an 
audio group is present by assigning it a number. For example, 1 
indicates the presence of audio group 1, and 2 indicates the presence of 
audio group 2. If an audio group is not present in the input, double 
dashed lines (=) represent the missing audio group. Table 3-2 provides 
examples of Audio Group Present parameter feedback. 

Table 3-2. Audio Group Present Feedback Examples

Parameter Feedback Meaning
1 2 3 4 All four audio groups are present.

= = = = No audio groups are present.

1 2= 4 Audio groups 1, 2, and 4 are present. 
Audio group 3 is not present.
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The Audio Channel Pair Feedback parameter indicates whether or not 
audio or audio data is present within each audio group. Figure 3-10 
illustrates the meaning of each feedback symbol. 

Figure 3-10. Audio Channel Pair Feedback 

To demux input embedded audio groups and pairs, follow these steps:
1. To determine which audio groups and pairs are present in the SDI 

input video stream, make the following selections:

2. Select which audio groups and pairs you want to demux.

Group 1 Group 2 Group 3 Group 4

aa dd

No audio 
present

Uncompressed 
audio (PCM)
present

Compressed 
audio (data) 
present

No audio 
present

Setting Description Parameter Navigation
Determine which audio groups 
are present.

Audio Setup  Input  Audio Group Present
[4, 9]

(displays feedback, 
see Table 3-2)

Determine the status of audio 
group channel pairs.

Audio Channel Pair 
Feedback [4, A]

(displays feedback, 
see Figure 3-10)

Setting Description Parameter Navigation
Select the audio groups/pairs you 
want to demux.

Audio Setup  Input  Audio Demux 
Source [2, 2]

• Demux Grp 1 & 2
• Demux Grp 3 & 4
• Custom

Select an action for when 
demuxing errors occur.

Demux Error Control
[2, 1]

• Mute
• Repeat
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3. If you selected Custom for the Audio Demux Source parameter, 
you can select up to four channel pairs from the combination of 
detected audio groups. To select channel pairs, make the following 
selections:

Selecting and Configuring Output Audio
The following sections describe how to select and configure settings for 
the audio groups/pairs you want to embed in the SDI output.

Selecting Output Audio Groups/Pairs
To select the audio groups/pairs that you want to embed, make the 
following selections:

Setting Description Parameter Navigation
Select your Custom Audio Pair 1 
to Audio Pair 4 to demux.

Audio Setup  Input  Audio Pair 1 Select 
to Audio Pair Select 4
[2, 3 to 2, 6]

(select a Grp/Pr)

Setting Description Parameter Navigation
Select the audio group in which 
you want to embed audio 
channel Pair 1 and Pair 2.

Audio Setup  Output  Audio Pair 1 & Pair 
2 Output Group [3, 1]

(select a Group)

Select the audio group in which 
you want to embed audio 
channel Pair 3 and Pair 4.

Audio Pair 3 & Pair 4 
Output Group [3, 2]

(select a Group)
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Bypassing Source Audio 
If you are embedding compressed audio channel pairs, you can set the 
Audio Master Bypass parameter so that these audio sources bypass the 
module’s audio processors and audio synchronizer. The XHD6800+A 
can detect automatically, by means of the channel status bit (C-bit), the 
presence of non-PCM audio signals such as Dolby® E. Upon detection 
of non-PCM data in “Auto” mode, the audio synchronizer and 
processor blocks are bypassed in order to maintain the integrity of the 
audio stream. To set the audio bypass parameters, make the following 
selections:

Setting Audio Pair Delay
You can configure audio delay (in msec) for each audio channel pair to 
compensate for any upstream video processing. Audio pair delay is 
added before audio embedding and is additive to the delay set by the 
Input Frame Delay parameter (see “Synchronization and Delay” on 
page 35). 
To set audio pair delay make the following selection:

Setting Description Parameter Navigation
Enable Audio Bypass. Audio Setup  Processing  Audio Master Bypass

[3, 3]
• Auto
• On
• Off 

If you selected On for the Audio 
Bypass parameter, you can 
select the audio pairs you want 
bypassed. 

Audio Pair Bypass 1 to 
Audio Pair Bypass 4
[3, 4 to 3, 7]

• On
• Off

Display the bypass status of the 
audio channel pairs. Bypassed 
channels are indicated by a “b”.

Audio Bypass 
Feedback [4, C]

(displayed 
feedback)

Setting Description Parameter Navigation
Set the audio delay for Audio 
Pair 1 to Audio Pair 4.

Audio Setup  Processing  Audio Pair 1 Delay 
to Audio Pair 4 Delay
[2, C to 2, F]

(select a delay value)
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Setting Audio Pair Gain
You can set audio gain for PCM (uncompressed) output audio channel 
pairs before they are embedded in the output SDI stream. To set audio 
gain, make the following selections:

Setting Description Parameter Navigation
Set the audio gain for Audio Pair 
1 to Audio Pair 4.

Audio Setup  Processing Audio Pair 1 Gain to
Audio Pair 4 Gain
[2, 8 to 2, B]

(select a gain value)
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Miscellaneous Configuration

Setting Output Video Phasing
Using the output video phasing parameters, you can adjust the 
horizontal and vertical phasing values of your output SD video. The 
range of the values that you can use for phase adjustment depends on 
your output video standard. Table 3-3 lists the horizontal and vertical 
phasing for each output video standard.

To adjust the horizontal and vertical phasing of your output video, make 
the following selections:

Configuring Closed Captioning
You can use the closed captioning parameters to enable or disable 
embedding of closed captioning data. 
To remove residual evidence of closed captioning at the top of the 
screen, use the cropping controls. 

Setting and Configuring GPIO 
If you have the optional XHD6800+A back module with GPIO 
connectors, the XHD6800+A will provide the following GPIO:

Table 3-3. Vertical and Horizontal Phasing Values

SD-SDI Output Video Standard/
Frame Rate

Parameter Name 525 625

Horizontal Phase 0 to 1715 pixels 0 to 1727 pixels

Vertical Phase 0 to 524 lines 0 to 624 lines

Setting Description Parameter Navigation
Select a value for horizontal 
phase adjustment.

Video Setup  Output  Output H Phase 
[0, B]

(select a value) 
(see Table 3-3.for 
option ranges)

Select a value for vertical phase 
adjustment.

Output V Phase
[0, C]

(select a value) 
(see Table 3-3.for 
option ranges).
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• Four general purpose (GP) inputs for recall of preset ARC/picture 
format memories or turning on the Test Generator.

• Two GP outputs for signaling a preset ARC/picture format or a 
signal loss.

The front module will auto-detect the type of the back module (GPIO 
versus non-GPIO). In case the non-GPIO back module is detected, the 
following controls for GPIO will be disabled. 

Table 3-4. Parameters that Will be Unavailable without GPIO

GPI GPO
GPI #1 Trigger Select GPO #1 State Select

GPI #1 Event Set GPO #1 Event Set

GPI #2 Trigger Select GPO #2 State Select

GPI #2 Event Set GPO #2 Event Set

GPI #3 Trigger Select GPO Status [RO]

GPI #3 Event Set

GPI #4 Trigger Select

GPI #4 Event Set

GPI Status [RO]
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Chapter 4

Parameters, LEDs, and Alarms

Overview
This chapter describes the parameters, options, alarms, and LEDs for 
the XHD6800+A module.
The following topics are discussed in this chapter: 
• “Parameter Tables” on page 59
• “LEDs and Alarms” on page 85

Parameter Tables
The parameters are listed in the order that they appear in CCS Pilot and 
Navigator. If you are using + Pilot Lite, some parameters in the list may 
not appear in the order as they appear in the software.

Note

If you are using card-edge controls to configure your XHD6800+ 
module, you can use the OSD Monitoring feature to view the 
current parameter selections. When the On-Screen Display 
parameter is turned on, the current parameter selections are 
displayed on module’s monitoring outputs. For information on 
enabling OSD Monitoring, see “Enabling On-Screen Display” on 
page 31.
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When viewing the control parameter tables, observe the following:
• Shaded table rows indicate read-only (feedback) parameters. 
• Bolded parameter options indicate the default settings for the 

parameter. 
• The bank selection and rotary switch combinations for each 

parameter and parameter option are listed in the tables under the 
Bank, Switch heading. For information about navigating through 
the parameter list using the card-edge controls, see “Changing 
Parameter Settings Using Card-Edge Controls” on page 29.

• Table 4-1 on page 60 lists XHD6800+A video setup parameters. 
• Table 4-2 on page 74 lists XHD6800+A audio setup parameters.
• Table 4-3 on page 78 lists other XHD6800+A parameters.

Video Setup Parameters
.

Table 4-1. Video Setup Parameters 

Navigation Parameter Name

B
an

k,
 

Sw
itc

h 

Function Options

Input Input Video Standard 
Detect

4, 2 Displays the detected input 
video standard

• Unknown
• 525
• 625

Input Frame Delay 1, 3 Sets the amount of input 
frame delay

0 to 6 frames

Force Freeze 8, F Selects the freeze type for the 
frame synchronizer

• Off 
• Frame
• Field 1
• Field 2

Frame Sync Freeze 
Status

4, 3 Confirms whether the output 
video is frozen

• Yes
• No

EDH Error Count Poll 
Interval(s)

1, 1 Defines the polling interval 
for EDH (Error Detection 
Handling) 

1 to 14400 sec 
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EDH Error Count Clear 1, 2 Clears the EDH error count • No 
• Yes 

EDH Present 5, 1 Indicates the presence of 
EDH

• Yes
• No

EDH Error Count 5, 2 Displays the EDH error count 0 to 4,294,967,295

Input CC Present 4, 4 Indicates the presence of 
closed captioning

• No
• Yes

AFD Detected      6, 1 Indicates presence of AFD 
packet

• No
• Yes

AFD Remove      6, 2 Controls the removing of 
AFD data

• No 
• Yes

VI Detect Line Field 1 6, 3 Controls the video line 
number to detect VI packet 
embedded in field 1

• 11 to 19(525) (14) 
• 8 to 23 (625) (11)

VI Detect Line Field 2 6, 4 Controls the video line 
number to detect VI packet 
embedded in field 2

• 274 to 282 (525) (277) 
• 321 to 336 (625) (324) 

VI Scan Detected      6, 5 Indicates the presence of VI 
packet Scan Part

• No 
• Yes

VI AFD Detected      6, 6 Indicates the presence of VI 
packet AFD Part

• No 
• Yes

VI Remove      6, 7 Controls the removing of VI 
data

• No 
• Yes

WSS Detect Line 6, 8 Controls the video line 
number to detect WSS packet 
embedded in field 1

N/A (525); 
8 to 23 (625)

WSS Detected      6, 9 Indicates the presence of 
WSS packet

• No 
• Yes

WSS Remove      6, A Controls the removing of 
WSS data

• No 
• Yes

Table 4-1. Video Setup Parameters (Continued)

Navigation Parameter Name

B
an

k,
 

Sw
itc

h 

Function Options
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Reference Genlock Source 0, D Selects the genlock source • External Ref 
• Frame Ref
• Free Run
• Delay

Reference Standard 0, E Selects the reference standard • Auto 
• NTSC/PAL-M
• TLS 720p59.94
• TLS 1080i59.94
• TLS 1080p29.97
• PAL-B
• TLS 720p50
• TLS 1080i50
• TLS 1080p25

Reference Video 
Standard Detect

4, D Displays the detected 
reference video standard

• Unknown
• NTSC/PAL-M
• TLS 720p59.94
• TLS 1080i59.94
• TLS 1080p29.97
• PAL-B
• TLS 720p50
• TLS 1080i50
• TLS 1080p25

Reference Locked 4, F Indicates if system timing is 
locked to the reference input

• No
• Yes
• Not applicable

Valid Reference 
Standard

4, E Indicates whether the 
detected reference video 
standard matches the selected 
output video standard

• No
• Yes
• Not applicable

Table 4-1. Video Setup Parameters (Continued)

Navigation Parameter Name

B
an

k,
 

Sw
itc

h 

Function Options
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Output Output Video Standard 0, 4 Selects an output video 
standard

• Auto 
• 525 
• 625 

On Screen Display 0, 2 Turns on/off the on-screen 
display

• Off
• On 

OSD Transparency 
Level 

0, 3 Sets the on-screen display 
transparency level

0 to 15

Loss of Video Output 0, 5 Selects an output option when 
loss of input occurs

• Pass 
• Black
• Freeze
• Test Pattern
• Sync Pass

Test Pattern Select 0, 6 Selects a test pattern (Test 
Pattern Display parameter 
must first be set to On)

• Color Bar 75% 
• Cross Hatch
• Freq Sweep
• White
• Black

Test Pattern Display 0, 7 Turn on/off the test pattern 
display

• Off 
• On

Safe Area 0, 8 Turns on/off various safe area 
overlays

• Off 
• Action On
• Title On
• Action & Title On

Video Keying 0, 9 Turns on/off video keying for 
the SDI output

• Off 
• Key Image
• Key Background

Table 4-1. Video Setup Parameters (Continued)
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Background Color 0, A Sets the background color • Black 
• Super Black
• Red 50%
• Green 50%
• Blue 50%
• Orange 50%
• Grey 50%
• Grey 40%
• Grey 25%

H Phase 0, B Sets the horizontal phase for 
the output signal

• 0 to 1715 pixels (525 
• 0 to 1727 pixels (625) 

V Phase 0, C Sets the vertical phase for the 
output signal

• 0 to 524 lines
(525)

• 0 to 624 lines (625)

CC Embed 3, 8 Turns on/off the closed 
caption embedding 

To remove residual evidence 
of closed captioning on line 
21 at the top of the video 
picture, use the cropping 
controls. 

• On 
• Off

AFD Insert    7, 1 Controls the embedding of 
the AFD packet

• Off 
• Auto
• Custom
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AFD Select    7, 2 Controls the AFD code that 
gets embedded; options 
depend on the Output 
Aspect Ratio parameter 
setting

When Output Aspect 
Ratio parameter is set to 
43 
• 16:9 top
• 14:9 top
• >16:9 in 4:3
• 4:3 full 
• 16:9 l
• 14:9 l
• 4:3 a 14:9
• 16:9 l a 14:9
• 16:9 l a 4:3
When Output Aspect 
Ratio parameter is set to 
169 
• 16:9 full
• 14:9 p
• >16:9 in 16:9
• 4:3 p
• 16:9 prtctd
• 4:3 p a 14:9
• 16:9 a 14:9
• 16:9 a 4:3

AFD Line Field 1 7, 3 Controls the video line 
number where the AFD 
packet gets embedded to in 
field 1

11 to 19 (525) (12) 
8 to 23 (625) 

AFD Line Field 2 7, 4 Controls the video line 
number where the AFD 
packet gets embedded to in 
field 2

274 to 282 (525) (275) 
320 to 336 (625) (327) 
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VI Insert    7, 5 Controls the embedding of 
the VI packet

• Off 
• Auto
• Custom 

VI Select    7, 6 Controls the VI code that gets 
embedded; options depend on 
the Output Aspect Ratio 
parameter setting

When Output Aspect 
Ratio parameter is set to 
4:3 
• 16:9 top
• 14:9 top
• >16:9 in 4:3
• 4:3 full 
• 16:9 l
• 14:9 l
• 4:3 a 14:9
• 16:9 l a 14:9
• 16:9 l a 4:3
When Output Aspect 
Ratio parameter is set to 
16:9 
• 16:9 full
• 14:9 p
• >16:9 in 16:9
• 4:3 p
• 16:9 prtctd
• 4:3 p a 14:9
• 16:9 a 14:9
• 16:9 a 4:3

VI Line Field 1 7, 7 Controls the video line 
number where the VI packet 
gets embedded to in field 1

12 to 19 (525) (14) 
8 to 23 (625) (11) 
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VI Line Field 2 7, 8 Controls the video line 
number where the VI packet 
gets embedded to in field 2

274 to 282 (525) (277) 
320 to 336 (625) (324) 

VI Emb with AFD 7, C Controls whether the VI 
output supports the AFD 
upper bits part

• No 
• Yes

WSS Insert    7, 9 Controls the embedding of 
the WSS packet

• Off 
• Auto
• Custom

WSS Select    7, A Controls the WSS code that 
gets embedded

• Full frame 
• 14:9 center
• 14:9 top
• 16:9 center
• 16:9 top
• >16:9 center
• Full a 14:9
• 16:9 Anamorphic

WSS Line 7, B Controls the video line 
number where the WSS 
packet gets embedded to in 
field 1

N/A (525)
7 to 23 (625) 

VBI Pass #1 8, 1 Selects one VBI line to pass 
transparently through the 
video processor

• 0, 12 to 22, 275 to 285 
(525)

• 0, 8 to 23, 321 to 335 
(625) 

VBI Pass #2 8, 2 Selects one VBI line to pass 
transparently through the 
video processor

• 0, 12 to 22, 275 to 285 
(525)

• 0, 8 to 23, 321 to 335 
(625) 

VBI Pass #3 8, 3 Selects one VBI line to pass 
transparently through the 
video processor

• 0, 12 to 22, 275 to 285 
(525)

• 0, 8 to 23, 321 to 335 
(625) 
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VBI Pass #4 8, 4 Selects one VBI line to pass 
transparently through the 
video processor

• 0, 12 to 22, 275 to 285 
(525)

• 0, 8 to 23, 321 to 335 
(625) 

VBI Pass #5 8, 5 Selects one VBI line to pass 
transparently through the 
video processor

• 0, 12 to 22, 275 to 285 
(525)

• 0, 8 to 23, 321 to 335 
(625) 

VBI Pass #6 8, 6 Selects one VBI line to pass 
transparently through the 
video processor

• 0, 12 to 22, 275 to 285 
(525)

• 0, 8 to 23, 321 to 335 
(625) 

VBI Pass #7 8, 7 Selects one VBI line to pass 
transparently through the 
video processor

• 0, 12 to 22, 275 to 285 
(525)

• 0, 8 to 23, 321 to 335 
(625) 

VBI Pass #8 8, 8 Selects one VBI line to pass 
transparently through the 
video processor

• 0, 12 to 22, 275 to 285 
(525)

• 0, 8 to 23, 321 to 335 
(625) 

VBI Pass #9 8, 9 Selects one VBI line to pass 
transparently through the 
video processor

• 0, 12 to 22, 275 to 285 
(525)

• 0, 8 to 23, 321 to 335 
(625) 

VBI Pass #10 8, A Selects one VBI line to pass 
transparently through the 
video processor

• 0, 12 to 22, 275 to 285 
(525)

• 0, 8 to 23, 321 to 335 
(625) 

VBI Pass #11 8, B Selects one VBI line to pass 
transparently through the 
video processor

• 0, 12 to 22, 275 to 285 
(525)

• 0, 8 to 23, 321 to 335 
(625) 
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VBI Pass #12 8, C Selects one VBI line to pass 
transparently through the 
video processor

• 0, 12 to 22, 275 to 285 
(525)

• 0, 8 to 23, 321 to 335 
(625) 

VBI Pass #13 8, D Selects one VBI line to pass 
transparently through the 
video processor

• 0, 12 to 22, 275 to 285 
(525)

• 0, 8 to 23, 321 to 335 
(625) 

VBI Pass #14 8, E Selects one VBI line to pass 
transparently through the 
video processor

• 0, 12 to 22, 275 to 285 
(525)

• 0, 8 to 23, 321 to 335 
(625) 

Processing Processing Bypass 0, 1 Disables video processing: 
ARC controls, crop controls, 
underscan mode

• Off 
• On

ARC 1, E Enables or disables the 
module’s aspect ratio 
converter

• Off 
• On 
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ARC Preset 1, 4 Selects a preset ARC 
configuration

• 4:3->4:3 Pillar
• 4:3->14:9 Pillar
• 4:3->16:9 Cut
• 4:3->16:9 Anamorphic 
• 4:3->21:9 Letter
• 16:9->16:9 Letter
• 16:9->14:9 Letter
• 16:9->4:3 Cut
• 16:9->4:3 Anamorphic
• 16:9->21:9 Letter
• Preset 1
• Preset 2
• Preset 3
• Preset 4
• Preset 5
• Custom
• AFD
• AFD(ALTR)
• VI
• VI(ALTR)
• WSS
• WSS(ALTR)

ARC H Scale Feedback 4, 5 Displays the current ARC 
horizontal phase

50% to 150% (see 
Table 3-3 on page 56)

ARC V Scale Feedback 4, 6 Displays the current ARC 
vertical phase

60% - 150% (see Table 3-3 
on page 56)

ARC H Offset 
Feedback

4, 7 Displays the current ARC 
horizontal offset

 -50.00% to 50.00%

ARC V Offset 
Feedback 

4, 8 Displays the current ARC 
vertical offset

 -50.00% to 50.00%
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ARC Transition Mode 1, 5 Sets the ARC transition mode • Cut 
• Linear
• S-curve 

ARC Transition 
Duration

1, 6 Sets the ARC transition 
duration

0 to 5.0 s, in 0.1 s 
increments 

ARC H Scale 1, 7 Sets the ARC horizontal scale 50% to 150%
(100) 
(see Table 3-3 on page 56)

ARC V Scale 1, 8 Sets the ARC vertical scale 60% - 150% (100) 
(see Table 3-3 on page 56)

ARC H Offset 1, 9 Sets the ARC horizontal 
offset

-50.00% to 50.00% (0)

ARC V Offset 1, A Sets the ARC vertical offset -50.00% to 50.00% (0)

ARC Preset Save 1, C Saves the current ARC 
configuration to a specific 
preset

• None 
• Preset 1
• Preset 2
• Preset 3
• Preset 4
• Preset 5
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ARC Preset Recall 1, D Recalls an ARC 
configuration

• None 
• 4:3->4:3 Pillar
• 4:3->14:9 Pillar
• 4:3->16:9 Cut
• 4:3->16:9 Anamorphic 
• 4:3->21:9 Letter
• 16:9->16:9 Letter
• 16:9->14:9 Letter
• 16:9->4:3 Cut
• 16:9->4:3 Anamorphic
• 16:9->21:9 Letter
• Preset 1
• Preset 2
• Preset 3
• Preset 4
• Preset 5

Arc Crop Top 6, C Top line of cropped picture 
position

0 - 5 (1)

Arc Crop Bottom 6, D Bottom line of cropped 
picture position

0 - 5 

Arc Crop Right 6, E Set number of pixels to crop 
on the right

0 - 20

Arc Crop Left 6, F Set number of pixels to crop 
on the left

0 - 20

Crop Mode 6, B Off disables crop controls.  
Resize scales the cropped 
input to the size of the 
uncropped image

• Off
• On
• Resize 

Output Active Picture 
Start

3, 9 Controls the line number for 
the start of the active picture

• Auto 
• line number
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Output Underscan 1, B Emulates "Underscan" mode 
of monitor; used for setting 
up input cropping

• Off 
• On

Motion Threshold 
Mode

3, A Sets the mode used to 
determine the motion 
threshold value

• Auto 
• Manual

Motion Manual 
Threshold

3, B Sets the threshold value for 
what is considered motion 
rather than noise when the 
Motion Threshold Mode is 
set to Manual 

1–16 (8)

Auto ARC Reset 7, D Controls whether to reset 
back to the original ARC 
setting when auto ARC 
packets disappear from the 
video

• Yes 
• No 

OutAspectRatio 4, 1 Sets the aspect ratio of the 
ARCing output

• 43 
• 169

Film Mode 1, F Controls the Film Mode 
detection

• Auto 
• Mixed
• Film
• Video
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Audio Setup Parameters 
Table 4-2. Audio Setup Parameters 

Navigation Parameter 
Name

B
an

k,
 

Sw
itc

h

Function Options

Input Audio Group 
Present

4, 9 Indicates the present audio group • ====
• 1===
• .....(all possible 

combinations)
• =234
• 1234

Audio Channel 
Pair Feedback 

4, A Displays the input audio channel pair
(See the example below.) 

•  ==aa==dd
• aadd==dd
• .....(all possible 

combinations)

Demux Error 
Control

2, 1 Selects an action when an error 
sample is selected

• Mute 
• Repeat

Audio Demux 
Source 

2, 2 Selects an audio source for 
demuxing

• Demux Grp 1 & 2 
• Demux Grp 3 & 4
• Custom

Audio Pair 1 
Select

2, 3 Selects a source for audio channel 
pair 1
(valid only when the Audio Demux 
Source parameter is set to Custom)

• Demux Grp 1 Pr 1 
• Demux Grp 1 Pr 2
• Demux Grp 2 Pr 1
• Demux Grp 2 Pr 2
• Demux Grp 3 Pr 1
• Demux Grp 3 Pr 2
• Demux Grp 4 Pr 1
• Demux Grp 4 Pr 2

Group 1 
present

Group 2 
present

Groups 
2 and 3 
present

All 
audio 
groups 
present

1 = = = = 2 = = = 2 3 = 1 2 3 4

No 
audio 
present

Audio 
present

No 
audio 
present

Data 
present

= = a a = = d d
Group 1 Group 2 Group 3 Group 4
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Audio Pair 2 
Select

2, 4 Selects a source for audio channel 
pair 2
(valid only when the Audio Demux 
Source parameter is set to Custom)

• Demux Grp 1 Pr 1
• Demux Grp 1 Pr 2 
• Demux Grp 2 Pr 1
• Demux Grp 2 Pr 2
• Demux Grp 3 Pr 1
• Demux Grp 3 Pr 2
• Demux Grp 4 Pr 1
• Demux Grp 4 Pr 2

Audio Pair 3 
Select

2, 5 Selects a source for audio channel 
pair 3 (valid only when the Audio 
Demux Source parameter is set to 
Custom)

• Demux Grp 1 Pr 1
• Demux Grp 1 Pr 2
• Demux Grp 2 Pr 1 
• Demux Grp 2 Pr 2
• Demux Grp 3 Pr 1
• Demux Grp 3 Pr 2
• Demux Grp 4 Pr 1
• Demux Grp 4 Pr 2

Audio Pair 4 
Select

2, 6 Selects a source for audio channel 
pair 4 
(valid only when the Audio Demux 
Source parameter is set to Custom)

• Demux Grp 1 Pr 1
• Demux Grp 1 Pr 2
• Demux Grp 2 Pr 1
• Demux Grp 2 Pr 2 
• Demux Grp 3 Pr 1
• Demux Grp 3 Pr 2
• Demux Grp 4 Pr 1
• Demux Grp 4 Pr 2

Output Audio Pair 1 & 2 
Output Group

3, 1 Selects the output group number to 
embed channel pair 1 and 2

• Group 1 
• Group 2 
• Group 3 
• Group 4 

Table 4-2. Audio Setup Parameters (Continued)

Navigation Parameter 
Name

B
an

k,
 

Sw
itc

h

Function Options
XHD6800+A Installation and Operation Manual 75



 Chapter 4: Parameters, LEDs, and Alarms
Audio Pair 3 & 4 
Output Group

3, 2 Selects the output group number to 
embed channel pair 3 and 4

• Group 1
• Group 2 
• Group 3 
• Group 4 

Processing Audio Master 
Bypass 

3, 3 Turns the master bypass on/off
(Auto mode uses the C-bit in the 
audio header to determine whether 
non-PCM audio is present or not)

• Auto 
• Off
• On

Audio Bypass 
Feedback

4, C Displays the bypass status of audio 
channels 

• ====
• b===
• .....(all possible 

combinations)
• =bbb
• bbbb 

Audio Pair 1 
Bypass

3, 4 Sets the bypass for audio channel 
pair 1

• On 
• Off

Audio Pair 2 
Bypass

3, 5 Sets the bypass for audio channel 
pair 2

• On 
• Off

Audio Pair 3 
Bypass

3, 6 Sets the bypass for audio channel 
pair 3

• On 
• Off

Audio Pair 4 
Bypass

3, 7 Sets the bypass for audio channel 
pair 4

• On 
• Off

Audio Master 
Mute 

2, 7 Turns the master mute on/off • Off 
• On

Table 4-2. Audio Setup Parameters (Continued)
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Channel 1 
bypassed

Channels 2 
and 3 
bypassed 

All 
channels 
bypassed

b = = = = b b = b b b b 
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Audio Mute 
Feedback

4, B Displays the mute status of 
embedded audio
(see the following example)

•  ====
• m===
• .....(all possible 

combinations)
• =mmm
• mmmm

Audio Pair 1 Gain 2, 8 Sets the gain level for audio channel 
pair 1

-6.0 to 6.0 dB (0)

Audio Pair 2 Gain 2, 9 Sets the gain level for audio channel 
pair 2

-6.0 to 6.0 dB (0)

Audio Pair 3 Gain 2, A Sets the gain level for audio channel 
pair 3

-6.0 to 6.0 dB (0)

Audio Pair 4 Gain 2, B Sets the gain level for audio channel 
pair 4

-6.0 to 6.0 dB (0)

Audio Pair 1 
Delay

2, C Sets the delay for audio channel pair 
1

0 to 1200 msec

Audio Pair 2 
Delay

2, D Sets the delay for audio channel pair 
2

0 to 1200 msec

Audio Pair 3 
Delay

2, E Sets the delay for audio channel pair 
3

0 to 1200 msec

Audio Pair 4 
Delay

2, F Sets the delay for audio channel pair 
4

0 to 1200 msec
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All audio is embedded 
= = = =
Embed 
pair 1

Embed 
pair 2

Embed 
pair 3

Embed 
pair 4

All audio is muted 
m m m m
Mute 
pair 1

Mute 
pair 2

Mute 
pair 3

Mute 
pair 4
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Other Setup Parameters 
Table 4-3. Other Setup Parameters 

Navigation Parameter Name
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GPIO GPI #1 Trigger Select 5, 8 Controls definition for the active 
state of the GPI line

• Off 
• High
• Low

GPI #1 Event Set 5, 9 Selects which function should be 
triggered when the GPI line becomes 
active

• 4:3->4:3 Pillar 
• 4:3->14:9 Pillar
• 4:3->16:9 Cut
• 4:3->16:9 

Anamorphic 
• 4:3->21:9 Letter
• 16:9->16:9 Letter
• 16:9->14:9 Letter
• 16:9->4:3 Cut
• 16:9->4:3 

Anamorphic
• 16:9->21:9 Letter
• Preset 1
• Preset 2
• Preset 3
• Preset 4
• Preset 5
• TestGen

GPI #2 Trigger Select 5, A Controls definition for the active 
state of the GPI line

• Off 
• High
• Low
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GPI #2 Event Set 5, B Selects which function should be 
triggered when the GPI line becomes 
active

• 4:3->4:3 Pillar 
• 4:3->14:9 Pillar
• 4:3->16:9 Cut
• 4:3->16:9 

Anamorphic 
• 4:3->21:9 Letter
• 16:9->16:9 Letter
• 16:9->14:9 Letter
• 16:9->4:3 Cut
• 16:9->4:3 

Anamorphic
• 16:9->21:9 Letter
• Preset 1
• Preset 2
• Preset 3
• Preset 4
• Preset 5
• TestGen

GPI #3 Trigger Select 5, C Controls definition for the active 
state of the GPI line

• Off 
• High
• Low
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GPI #3 Event Set 5, D Selects which function should be 
triggered when the GPI line becomes 
active

• 4:3->4:3 Pillar 
• 4:3->14:9 Pillar
• 4:3->16:9 Cut
• 4:3->16:9 

Anamorphic 
• 4:3->21:9 Letter
• 16:9->16:9 Letter
• 16:9->14:9 Letter
• 16:9->4:3 Cut
• 16:9->4:3 

Anamorphic
• 16:9->21:9 Letter
• Preset 1
• Preset 2
• Preset 3
• Preset 4
• Preset 5
• TestGen

GPI #4 Trigger Select 5, E Controls definition for the active 
state of the GPI line

• Off 
• High
• Low
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GPI #4 Event Set 5, F Selects which function should be 
triggered when the GPI line becomes 
active

• 4:3->4:3 Pillar 
• 4:3->14:9 Pillar
• 4:3->16:9 Cut
• 4:3->16:9 

Anamorphic 
• 4:3->21:9 Letter
• 16:9->16:9 Letter
• 16:9->14:9 Letter
• 16:9->4:3 Cut
• 16:9->4:3 

Anamorphic
• 16:9->21:9 Letter
• Preset 1
• Preset 2
• Preset 3
• Preset 4
• Preset 5
• TestGen

GPI Status 7, E Displays the status of all GPI lines • ====
• ===a
• ==a=
• ==aa
• … 
(leftmost digit = GPI 
1)

GPO #1 State Select 3, C Controls definition for the active 
state of the GPO line

• Off 
• Active High
• Active Low
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GPO #1 Event Set 3, D Selects the functionality of the GPO 
line upon becoming active

• 4:3->4:3 Pillar 
• 4:3->14:9 Pillar
• 4:3->16:9 Cut
• 4:3->16:9 

Anamorphic 
• 4:3->21:9 Letter
• 16:9->16:9 Letter
• 16:9->14:9 Letter
• 16:9->4:3 Cut
• 16:9->4:3 

Anamorphic
• 16:9->21:9 Letter
• Preset 1
• Preset 2
• Preset 3
• Preset 4
• Preset 5
• LOV

GPO #2 State Select 3, E Controls definition for the active 
state of the GPO line

• Off 
• Active High
• Active Low
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GPO #2 Event Set 3, F Selects the functionality of the GPO 
line upon becoming active

• 4:3->4:3 Pillar 
• 4:3->14:9 Pillar
• 4:3->16:9 Cut
• 4:3->16:9 

Anamorphic 
• 4:3->21:9 Letter
• 16:9->16:9 Letter
• 16:9->14:9 Letter
• 16:9->4:3 Cut
• 16:9->4:3 

Anamorphic
• 16:9->21:9 Letter
• Preset 1
• Preset 2
• Preset 3
• Preset 4
• Preset 5
• LOV

GPO Status 7, F Displays the status of all GPO lines • ==
• =a
• a=
• aa 
(leftmost digit = 
GPO 1)

Other Factory Recall 0, F Recalls the factory default settings • No
• Yes

Module Type 5, 5 Displays the current card type, 
which is based on the module’s 
feature set.

• XHD6800+U1
• XHD6800+U1+CC
• XHD6800+U2
• XHD6800+U2+CC
• XHD6800+A
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Serial Number 5, 6 Displays the module’s serial number (serial number)

License Key 5, 7 Displays the software license key 
used to unlock the last feature 
upgrade

(license key)

Module Type Match n/a Provides the matching status of 
Module type and firmware
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LEDs and Alarms
The XHD6800+A has a single module status LED and 13 monitoring 
LEDs to provide card-edge reference. XHD6800+A alarm information 
is available in CCS software only. Figure 4-1 shows the location of the 
module status and monitoring LEDs on a typical 6800+ module. 

Figure 4-1. Location of XHD6800+A LEDs

Monitoring LEDs
The XHD6800+A has 13 monitoring LEDs that serve as a quick 
monitoring reference. Table 4-4 on page 85 describes the meaning of 
the card-edge LEDs, from left to right.

Module 
status 
LEDs

Monitoring LEDs

Table 4-4. LED Status Indicators 

LED Description Color Indication
50-59 Not used N/A

Auto Not used N/A

525 Indicates the input standard is 525 Green: 525 input standard is detected

625 Indicates the input standard is 625 Green: 625 input standard is detected

720p Not used N/A

1080i Not used N/A
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Module Status LED
The XHD6800+A modules do not have any card-edge alarms. Instead, 
the module status LED on the corner of the module lights up if an error 
is detected. See Figure 4-1 on page 85 for the location of the LED, and 
Table 4-5 for a definition of the LED colors.

Note

If the LED is flashing red, please contact your Customer Service 
representative.

Audio1 Reports the presence of audio group 1 in the input 
video stream

Green: Group 1 audio is present

Audio2 Reports the presence of audio group 2 in the input 
video stream

Green: Group 2 audio is present

Audio3 Reports the presence of audio group 3 in the input 
video stream

Green: Group 3 audio is present

Audio4 Reports the presence of audio group 4 in the input 
video stream

Green: Group 4 audio is present

CC Indicates the presence of closed captioning Green: Closed captioning data is present

Reference Indicates the presence of a valid reference signal Green: Valid signal is present

Bypass Not used N/A

Table 4-4. LED Status Indicators (Continued)

LED Description Color Indication

Table 4-5. LED Color and Meaning

LED Color 
Sequence Meaning

Off There is no power to the module; the module is not 
operational.

Green There is power to the module; the module is operating 
properly.

Red There is an alarm condition.

Flashing Red The module has detected a hardware/firmware fault.

Amber The module is undergoing configuration.
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Alarms
Alarms are usually logged and monitored within software control 
applications such as + PilotLite or CCS Pilot. See the appropriate 
software control user manual or online help for more information.
Table 4-6 describes the specific alarms for XHD6800+ modules. 

Table 4-6.  XHD6800+ Alarms 

Alarm Name Alarm Description Alarm Level
SDI IP Video Present Loss of SDI input video Major 

RefLockedAlarm Loss of locked reference Major 

RefStdMismatch Mismatch between reference 
video and video standard

Major
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Chapter 5

Specifications

Overview
The following specification tables appear in this chapter:
• “SDI Video Input” on page 90
• “Genlock Input” on page 90
• “SD-SDI Reclocked Video Output” on page 91
• “SD-SDI Program Video Output” on page 91
• “Audio Delay (Data Out)” on page 92
• “Propagation Delay” on page 92
• “GPIO” on page 92
• “Performance” on page 93
Specifications and designs are subject to change without notice.
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Inputs
SDI Video Input

Genlock Input

Table 5-1. SD-SDI Video Input Specifications

Item Specification
Number of inputs 1

Standards SMPTE 259M-C 
(270 Mbps, 525/625 component video)

Connector BNC per IEC 169-8

Impedance 75Ω

Return loss >15 dB to 270 MHz

Equalization >23 dB (typical) Belden 8281 cable 

Table 5-2. Genlock Input Specifications

Item Specification
Connector BNC per IEC 169-8

Impedance 75Ω

Return loss >40 dB (typical) to 6 MHz 
>35 dB (typical) to 30 MHz

Common mode range 5.5 V pk-to-pk

CMRR 60 dB @ 60 Hz, 5 V pk-to-pk

Input level • NTSC/PAL-B (1 V pk-to-pk, -5.0 dB to 6.0 dB)
• Tri-Level Sync (1080i/720p) ± 300 mV, -3.5 dB to 

6.0 dB

Signal type • NTSC/PAL-B analog composite
• ± 300 mV Tri-Level Sync (1080i/720p)
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Outputs

SD-SDI Reclocked Video Output 

SD-SDI Program Video Output 

Table 5-3. SD-SDI Reclocked Output Specifications

Item Specification
Number of outputs 2 

Standard SMPTE 259M-C (270 Mbps, 525/625 component 
video)

Connector BNC per IEC 169-8

Impedance 75Ω

Return loss >15 dB to 270 MHz

DC offset 0.0 V ± 0.5 V

Signal level 800 mV ± 10%

Rise and fall time 400 to 1500 ps (20% to 80%) at 270 MHz

Overshoot <10% of amplitude (all outputs terminated) 

Jitter <0.2 UI pk-to-pk

Table 5-4. SD-SDI Program Video Output Specifications 

Item Specification
Number of outputs 2 program, 2 monitor/program

Standard SMPTE 259M-C (270 Mbps, 525/625 component 
video)

Connector BNC per IEC 169-8

Impedance 75Ω

Return loss >15 dB to 270 MHz

DC offset 0.0 V ± 0.5 V

Signal level 800 mV ± 10%

Rise and fall time < 0.75 to 1.5 nss (20% to 80%) at 270 MHz

Overshoot <10% of amplitude (all outputs terminated) 

Jitter <0.2 UI pk-to-pk)
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Miscellaneous 

Audio Delay (Data Out)

Propagation Delay 

GPIO

Table 5-5. Audio Delay Specifications

Item Specification
Number of outputs 1

Connector BNC per IEC 169-8

Impedance 75Ω

Return loss >20 dB (typical) to 6 MHz

Table 5-6. Propagation Delay

Mode Specification
Delay 1 frame

Sync Between 1 and 2 frames:
• Between 0 and 1 frame through the 

frame synchronizer
• 1 frame through the scalar

Table 5-7. GPI Specifications

Item Specification
Inputs 4

Internally pulled HIGH
External contact closure to ground to trigger

Outputs 2
Buffered TTL levels

Connector RJ-45
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Performance 
Table 5-8. Performance Specifications

Item Specification
Power consumption <11 W 

Operating temperature 41° to 113°F (5° to 45°C)
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Appendix A

Communication and Control
Troubleshooting Tips

Overview
Find the following troubleshooting information in this appendix:
• “General Troubleshooting Steps” on page 96
• “Software Communication and Control Issues” on page 98
• “Hardware Communication and Control Issues” on page 102
• “Contacting Customer Service” on page 102
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General Troubleshooting Steps
Follow these steps in troubleshooting 6800+ product problems:
1. Review the “Software Communication and Control Issues” on 

page 98 outlined in this chapter.
2. Search this product manual and other associated documentation for 

answers to your question.

Note
Associated documentation for 6800+ series products can 
generally be found in the product-specific manual that 
accompanies every module, in the FR6802+ Frame Installation 
and Operation Manual, and in the 6800+ Safety Instructions 
and Standards Manual.

Product documentation (including manuals, online help, application 
notes, erratas, product release notes, and more) can be found on our 
website, along with technical support information, training 
information, product downloads, and a product knowledge base.

3. Contact your Customer Service representative if, after following 
these initial steps, you cannot resolve the issue.
To contact Customer Service, see “Contacting Customer Service” 
on page 102.
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Control and Monitoring Using CCS Software
Before using CCS software applications to control and monitor your 
module, you must refresh (+ Pilot Lite) or discover (Pilot and 
Navigator) the module. Refresh and Discovery are the processes by 
which your CCS software finds, and then connects to your module.

Refreshing Your Module Using + Pilot Lite
When using + Pilot Lite to change your XHD6800+A control 
parameters, you must “refresh” the control connection between your 
6800+ frame and PC. To refresh the connection, from the + Pilot Lite 
menu bar, select File > Refresh. For information about controlling a 
device using + Pilot Lite, see your + Pilot Lite User Manual.

Discovering a XHD6800+A Module
To discover your module, your Pilot or Navigator software must be in 
Build mode. Follow these steps: 
1. If the Discovery window is not open, click Tools > Discovery in the 

main menu. 
A Discovery window opens, most likely in the bottom left corner of 
the screen. 

2. Click Options, and then click Add.
3. Enter the IP address of the frame that contains your module, the 

frame that contains your ICE6800+ module, or the frame that 
contains a 6800+ETH module that provides access to your module. 

4. Click OK to close the Add IP address window, and then OK again 
to close the Discovery Options window. 

5. Click Start. 
This triggers Pilot or Navigator to run a discovery. 

6. When your discovery is complete, Discovery Completed is 
displayed in the Discovery window. To continue, click Save, to 
save the contents of your discovery to the Discovery folder of the 
Navigation pane. 

You can now switch to Control mode by selecting Operational Mode > 
Control from the main menu. Double-click XHD6800+A in the 
Navigation pane. The Control window opens, displaying the module’s 
controls.
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Software Communication and Control Issues
• “+ Pilot Lite Fails to Communicate with Installed Modules” on 

page 98
• “+ Pilot Lite Does Not Find All Modules in Frame” on page 99
• “+ Pilot Lite or CCS Software Application Not Responding” on 

page 100
• “+ Pilot Lite Cannot Control a Module Showing 

in the Control Window” on page 100
• “+ Pilot Lite Status Bar Reports ‘Not Ready’” on page 100
• “CCS Software Application or Remote Control Panel Does Not 

Communicate with Module” on page 101
• “Alarm Query Fails When a Device Reboots” on page 101

+ Pilot Lite Fails to Communicate with Installed Modules
Confirm that the following items are not the reason for the 
communication failure:
• The proper module slot has not been specified (+ Pilot Lite is not 

communicating with the appropriate slot). See your FR6802+ 
Frame Installation and Operation Manual for more information on 
slot identification.

• The COM port is used elsewhere (Check that the correct COM port 
is configured in + Pilot Lite and that another application is not 
using that COM port).

• The actual frame ID does not match with the two DIP switch 
settings in the back of the frame (+ Pilot Lite is not communicating 
with the proper frame). See your FR6802+ Frame Installation and 
Operation Manual for more information on frame ID switch 
settings.

• A null modem cable is not being used. Between the PC running 
+ Pilot Lite and the FR6802+ frame, there should be a null RS-232 
modem cable. At minimum, this requires that pins 2 and 3 are 
crossed and 5 to 5 for ground. 

• An ICE6800+ or 6800+ETH module is installed in the frame 
(+ Pilot Lite control is disabled if an ICE6800+ or 6800+ETH 
control module is installed in the frame; ICE6800+ and 6800+ETH 
modules are used for CCS control).
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• A legacy 6800 series product is in the frame. + Pilot Lite cannot 
communicate with legacy 6800 series products. They will not be 
discovered or controlled by + Pilot Lite, although they can be 
installed in the FR6802+ frame and work using card-edge controls. 
The module must be from the 6800+ product family.

• Check that the back module does not have any bent pins, following 
this procedure:
a. Unplug the front module. 
b. Unscrew and remove the back module.
c. View the 20-pin spring connector at the bottom of the back 

module.(See Figure A-1.)

Figure A-1. Back Module to Front Module Connector

This connector should not have any bent or pressed pins. Even 
a slightly depressed or bent pin may cause genlock issues. 

d. If there are bent pins, carefully reposition them to their correct 
positions. 
If this is not possible, you can exchange the back module for a 
new one (order part number XHD6800+ADR). 

+ Pilot Lite Does Not Find All Modules in Frame
If a discovery is started too soon after frame power-up, + Pilot Lite will 
not find all the installed modules. Refresh + Pilot Lite (File > 
Refresh), and ensure that installed modules are fully powered-up first 
before discovery.

20-pin 
connector
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If a module is plugged into the frame after a discovery, + Pilot Lite 
does not automatically detect the module. Refresh + Pilot Lite (File > 
Refresh) to discover the newly installed module.
If a Legacy 6800 series product is in the frame, + Pilot Lite will not 
detect it. + Pilot Lite cannot communicate with legacy 6800 series 
products. They will not be discovered or controlled by + Pilot Lite 
although they can be installed in the FR6802+ frame and work using 
card edge controls. For + Pilot Lite to find a module, it must be from 
the 6800+ product family.

+ Pilot Lite or CCS Software Application Not Responding
+ Pilot Lite and CCS applications such as Navigator or Pilot cannot run 
on the same PC at the same time. Both applications can be installed, but 
only one can be opened at a time.

+ Pilot Lite Cannot Control a Module Showing 
in the Control Window

Consider these questions:
• Did you physically set the jumper for local control? If so, set this 

jumper to the REM position for remote control.
• Does the card name in the control window physically match the 

card type in the frame? 
• Is the module properly seated in the frame? Check the positioning 

of the module in its slot in the frame.
• Does the Control window indicate the device is “ready”? The 

device may be powered off or disconnected from the network.

+ Pilot Lite Status Bar Reports ‘Not Ready’ 
+ Pilot Lite reports each device’s connection status in the status bar. If 
the connection status message reads “Not Ready,” check the following:
• Is the module properly seated in the frame? Check the position of 

the module in the frame.
• Is the frame connected to the network? Check the device’s network 

connection.
If the status bar still reports no status or “Not Ready” for the frame or 
device, try restarting + Pilot Lite. 
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CCS Software Application or Remote Control Panel Does 
Not Communicate with Module

CCS software applications (such as Pilot, CoPilot, and Navigator) and 
remote control panels require the purchase and installation of an 
ICE6800+ module in an FR6802+ frame (or an ICE6800+ or 
6800+ETH module in a FR6802+QXF frame) in order to communicate 
remotely via Ethernet.

Alarm Query Fails When a Device Reboots
When you reboot a device connected to your PC, the alarm traffic 
hitting the network may cause an alarm query request to time out and 
fail. While the query does not automatically retry, it will post an “Alarm 
query failed” message to the Diagnostics window.
To clear an “Alarm query failed” message, right-click inside 
the Diagnostics window, and then select Refresh from the resulting 
context menu.
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Hardware Communication and Control Issues
• “Frames Fail to Communicate with the PC after a Power Failure” 

on page 102
• “Module Does Not Seem to Work” on page 102

Frames Fail to Communicate with the PC after a Power 
Failure

You must exit the software and restart after the frame recovers from its 
power failure. To restore communications between the PC and the 
frames, ensure that the frames have three or more minutes to recover 
from the power failure before you exit the application and restart the 
PC.

Module Does Not Seem to Work
Although the following troubleshooting tips may seem obvious, please 
take the time to ensure the following:
• All appropriate rear connections are securely made
• The board is securely installed (with no bent pins)
• The frame is turned on

Contacting Customer Service
We are committed to providing round-the-clock, 24-hour service to our 
customers around the world. Visit our website for information on how 
to contact the Customer Service team in your geographical region.
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